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 Preface 
 
 
 
 
 
 
This chapter introduces Cisco Unified CallConnector Server for Microsoft Windows® 
(referred to as the Unified CallConnector Server or as the UCC Server), describes the 
purpose of this document, and outlines the required software. The chapter includes the 
following topics: 
 
 

• Purpose 

• Audience 

• Organization 

• Related Documentation 

• Required Software 

• Supported Windows Platforms 

• Conventions 

• Obtaining Documentation 

• Documentation Feedback 

• Cisco Product Security Overview 

• Obtaining Technical Assistance 

• Obtaining Additional Publications and Information 
. 

 
CHAPTER 

1 
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 Purpose 
 
This manual is intended for system administrators and technical support individuals who 
will be setting up and configuring the Unified CallConnector Server.  

 

Unified CallConnector Server consists of a set of server applications that provide shared 
access to control of telephones, database and services to the Unified CallConnector 
clients. This purpose of this guide is to provide step-by-step instructions to install and 
setup these server applications.. The document also provides instructions for using the 
diagnostic tool to isolate problems encountered in the operation and usage of the 
CallConnector solution.  

 

This document also provides links to additional product information and the methods and 
options for accessing support. The last chapter provides some troubleshooting 
information to allow you to isolate problems that you might be experiencing.  

 
 

Audience 
This manual is intended for system administrators and technical support personnel who 
will be setting up and configuring the Unified CallConnector server and supporting the 
Unified CallConnector end-users.  

 
The user guide assumes that you know the basics of using your computer and are 
familiar with Windows, using a mouse and selecting items from a dialog box. 
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Organization 
 
 
This guide contains nine chapters: 
 
Preface -  This chapter provides an overview of the Administrator 

Guide and describes how to use the manual. 

Overview -  This chapter provides an overview of the Unified 
CallConnector Solution and describes the configurations 
for the Unified CallConnector server. 

Installation-  This chapter describes how to install and register the 
Unified CallConnector Server. 

Configuring Server Apps -  This chapter describes how to setup and configure the 
Unified CallConnector server application and the users. 

Configuring Cisco Unified 

CME- This chapter provides instructions for setting up the 
required parameters on the Cisco Unified CME router. 

Starting and Stopping - This chapter describes how to start and stop the Unified 
CallConnector server applications which run as Windows 
services. 

Managing Data -  This chapter describes how to manage the configuration 
and transaction data associated with the Unified 
CallConnector server. 

Using Diagnostic Tool  -  This chapter provides step-by-step instruction for 
running the diagnostic application and the problem 
isolation tests. 

Troubleshooting -  This chapter describes the tools and procedures for 
troubleshooting problems with your the Unified 
CallConnector solution.  
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Related Documents 
For more information about the Unified CallConnector please visit the Cisco System site: 
 
http://www.cisco.com/go/unifiedcallconnector 

Required Telephone Systems 
The Unified CallConnector supports the following Cisco Systems Unified 
Communications managers  and telephones. Please visit the Cisco Systems site for the 
Unified CallConnector for the latest product compatibility list. 
 
Cisco Unified Communications Manager Express version 4.1.  

Supported Windows Platforms 
The following Windows operating systems and application versions are supported by the 
Unified CallConnector Server: 
 
Windows 2000 Server, Windows 2003 Server 
Microsoft Internet Explorer version 6.0 and 7.0 
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Conventions 
The following conventions are used in this guide: 
 
Convention  Description 

boldface  font Commands and keywords are in boldface. 

italic font  Arguments for which you supply values are in italics. 

[ ]  Elements in square brackets are optional. 

{ x | y | z }  Alternative keywords are grouped in braces and 
separated by vertical bars. 

[ x | y | z ]  Optional alternative keywords are grouped in brackets 
and separated by vertical bars. 

string  An unquoted set of characters. Do not use quotation 
marks around the string or the string will include the 
quotation marks. 

screen font  Terminal sessions and information that the system 
displays are in screen font. 

boldface screen  Information you must enter is in boldface screen  

font font 

italic screen font  Arguments for which you supply values are in italic 
screen font. 

This pointer highlights an important line of text in an 
example. 

^  The symbol ^ represents the key labeled Control—for 
example, the key combination ^D in a screen display 
means hold down the Control key while you press the D 
key. 

< > Nonprinting characters, such as passwords are in angle 
brackets. 

Conventions Used 
The following conventions are used in this guide: 
 
Most of the operations of the Unified CallConnector Server applications can be initiated 
by using either the mouse or keyboard.  The administrator guide provides the instructions 
for both these methods.  The body of the text describes the operation in more detail. 
 
The names of keys appear in bold capital letters: ENTER 
 
Information that you type appears in small, light typeface: Unified CallConnector 
 
Menu commands appear in bold and are abbreviated in the text. For example the Print 
command on the File menu is indicated by File-Print. The names of buttons in dialog 
boxes also appear in bold. 
 
Actions you take or procedures for you to follow are indicated by indented and bulleted 
steps. 
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Terminology 
The following terms are used frequently in the manual to identify different kinds of 
individuals and objects. 
 
Term Meaning 

Administrator The person responsible for the administration of the 
Unified CallController system.  

UCC Unified CallConnector.  

Group A collection of users. A group is also displayed as the 
department in the corporate directory. 

Manager The person responsible for a group of agents. 

Database A database is a file that contains information in a tabular 
format.  

Record or Entry Each row of the database table is called an entry or a 
record. 

Field Each column of the database table is called a field. 

Directory A directory is a database that usually contains names 
and related information. 

Presence Real-time availability status of a user. Presence status 
can include availability, location , telephone status and 
away messages.  

Server Named directory containing control and data files. 

Users Individuals who are authorized to use the system. 

Dialog Popup window from which options are selected. 

Window An area of the screen where the application displays 
information. 

SIP Session Initiation Protocol – a standardized set of 
messages and methods for setting up communication 
sessions. 

Service An application running as a Windows Service. These 
applications do not  present a user interface. 

RADIUS Remote Authentication Dial In User Service (RADIUS) is 
an AAA (authentication, authorization and accounting) 
protocol for applications such as network access or IP 
mobility.  

Port Sub-address used in setting up TCP connections. 



Introduction 

Administrator Guide   1-7 

Using the Mouse 
The following terms are used in the manual when describing mouse-based operations: 
 
Term Meaning 

Point Move the mouse pointer on screen to the desired item or 
location. 

Select Click on the item of choice. 

Click Quickly press and release the left mouse button. 

Right-Click Quickly press and release the right mouse button. 

Double-Click Quickly press and release the left mouse button twice in 
succession. 

Drag&Drop Click down on item, holding down the button, move the 
mouse pointer to desired location, and then release the 
button.  

Obtaining Documents 
Cisco documentation and additional literature are available on Cisco.com. Cisco also 
provides several ways to obtain technical assistance and other technical resources. 
These sections explain how to obtain technical information from Cisco Systems. 
 

Cisco.com 
You can access the most current Cisco documentation at this URL: 
http://www.cisco.com/univercd/home/home.htm 
 
You can access the Cisco website at this URL: 
http://www.cisco.com 
 
You can access international Cisco websites at this URL: 
http://www.cisco.com/public/countries_languages.shtml 
 

Documentation DVD 
Cisco documentation and additional literature are available in a Documentation DVD 
package, which may have shipped with your product. The Documentation DVD is 
updated regularly and may be more current than printed documentation. The 
Documentation DVD package is available as a single unit. 
 
Registered Cisco.com users (Cisco direct customers) can order a Cisco Documentation 
DVD (product number DOC-DOCDVD=) from the Ordering tool or Cisco Marketplace. 
 
Cisco Ordering tool: 
http://www.cisco.com/en/US/partner/ordering/ 
 
Cisco Marketplace: 
http://www.cisco.com/go/marketplace/ 
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Ordering Documentation 
You can find instructions for ordering documentation at this URL: 
 
http://www.cisco.com/univercd/cc/td/doc/es_inpck/pdi.htm 
 
You can order Cisco documentation in these ways: 
 
Registered Cisco.com users (Cisco direct customers) can order Cisco product 
documentation from the Ordering tool: 
 
http://www.cisco.com/en/US/partner/ordering/ 
 
Nonregistered Cisco.com users can order documentation through a local account 
representative by calling Cisco Systems Corporate Headquarters (California, USA) at 408 
526-7208 or, elsewhere in North America, by calling 1 800 553-NETS (6387). 
 

Documentation Feedback 
You can send comments about technical documentation to: 
bug-doc@cisco.com 
 
You can submit comments by using the response card (if present) behind the front cover 
of your document or by writing to the following address: 
 
Cisco Systems 
Attn: Customer Document Ordering 
170 West Tasman Drive 
San Jose, CA 95134-9883 
 
We appreciate your comments. 
 
 



Introduction 

Administrator Guide   1-9 

Cisco Product Security Overview 
Cisco provides a free online Security Vulnerability Policy portal at this URL: 
 
http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html 
 
From this site, you can perform these tasks: 
 
Report security vulnerabilities in Cisco products. 
Obtain assistance with security incidents that involve Cisco products. 
Register to receive security information from Cisco. 
 
A current list of security advisories and notices for Cisco products is available at this 
URL: 
http://www.cisco.com/go/psirt 
 
If you prefer to see advisories and notices as they are updated in real time, you can 
access a Product Security Incident Response Team Really Simple Syndication (PSIRT 
RSS) feed from this URL: 
 
http://www.cisco.com/en/US/products/products_psirt_rss_feed.html 
 
 

Reporting Security Problems in  Cisco Products 
Cisco is committed to delivering secure products. We test our products internally before 
we release them, and we strive to correct all vulnerabilities quickly. If you think that you 
might have identified a vulnerability in a Cisco product, contact PSIRT: 
 
Emergencies—security-alert@cisco.com 
Nonemergencies—psirt@cisco.com 
 
Tip We encourage you to use Pretty Good Privacy (PGP) or a compatible product to 
encrypt any sensitive information that you send to Cisco. PSIRT can work from encrypted 
information that is compatible with PGP versions 2.x through 8.x. Never use a revoked or 
an expired encryption key. The correct public key to use in your correspondence with 
PSIRT is the one that has the most recent creation date in this public key server list: 
 
http://pgp.mit.edu:11371/pks/lookup?search=psirt%40cisco.com&op=index&ex act=on 
 
In an emergency, you can also reach PSIRT by telephone: 
• 1 877 228-7302 
• 1 408 525-6532 
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Obtaining Technical Assistance 
For all customers, partners, resellers, and distributors who hold valid Cisco service 
contracts, Cisco Technical Support provides 24-hour-a-day, award-winning technical 
assistance. The Cisco Technical Support Website on Cisco.com features extensive 
online support resources. In addition, Cisco Technical Assistance Center (TAC) 
engineers provide telephone support. If you do not hold a valid Cisco service contract, 
contact your reseller. 
 

Cisco Technical Support Website 
The Cisco Technical Support Website provides online documents and tools for 
troubleshooting and resolving technical issues with Cisco products and technologies. The 
website is available 24 hours a day, 365 days a year, at this URL: 
 
http://www.cisco.com/techsupport 
 
Access to all tools on the Cisco Technical Support Website requires a Cisco.com user ID 
and password. If you have a valid service contract but do not have a user ID or 
password, you can register at this URL: 
 
http://tools.cisco.com/RPF/register/register.do 
 
Note Use the Cisco Product Identification (CPI) tool to locate your product serial number 
before submitting a web or phone request for service. You can access the CPI tool from 
the Cisco Technical Support Website by clicking the Tools & Resources link under 
Documentation & Tools. Choose Cisco Product Identification Tool from the 
Alphabetical Index drop-down list, or click the Cisco Product Identification Tool link 
under Alerts & RMAs. The CPI tool offers three search options: by product ID or model 
name; by tree view; or for certain products, by copying and pasting show command 
output. Search results show an illustration of your product with the serial number label 
location highlighted. Locate the serial number label on your product and record the 
information before placing a service call. 
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Submitting a Service Request 
Using the online TAC Service Request Tool is the fastest way to open S3 and S4 service 
requests. (S3 and S4 service requests are those in which your network is minimally 
impaired or for which you require product information.) After you describe your situation, 
the TAC Service Request Tool provides recommended solutions. If your issue is not 
resolved using the recommended resources, your service request is assigned to a Cisco 
TAC engineer. The TAC Service Request Tool is located at this URL: 
 
http://www.cisco.com/techsupport/servicerequest 
 
For S1 or S2 service requests or if you do not have Internet access, contact the Cisco 
TAC by telephone. (S1 or S2 service requests are those in which your production 
network is down or severely degraded.) Cisco TAC engineers are assigned immediately 
to S1 and S2 service requests to help keep your business operations running smoothly. 
To open a service request by telephone, use one of the following numbers: 
 
Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227) 
EMEA: +32 2 704 55 55 
USA: 1 800 553-2447 
 
For a complete list of Cisco TAC contacts, go to this URL: 
http://www.cisco.com/techsupport/contacts 
 

Definition of Service Request Severity 
To ensure that all service requests are reported in a standard format, Cisco has 
established severity definitions. 
 
Severity 1 (S1)—Your network is “down,” or there is a critical impact to your business 
operations. You and Cisco will commit all necessary resources around the clock to 
resolve the situation. 

Severity 2 (S2)—Operation of an existing network is severely degraded, or significant 
aspects of your business operation are negatively affected by inadequate performance of 
Cisco products. You and Cisco will commit full-time resources during normal business 
hours to resolve the situation. 

Severity 3 (S3)—Operational performance of your network is impaired, but most business 
operations remain functional. You and Cisco will commit resources during normal 
business hours to restore service to satisfactory levels. 

Severity 4 (S4)—You require information or assistance with Cisco product capabilities, 
installation, or configuration. There is little or no effect on your business operations. 
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Obtaining Additional Publications Information 
Information about Cisco products, technologies, and network solutions is available from 
various online and printed sources. 
 
Cisco Marketplace provides a variety of Cisco books, reference guides, and logo 
merchandise. Visit Cisco Marketplace, the company store, at this URL: 
http://www.cisco.com/go/marketplace/ 
 
Cisco Press publishes a wide range of general networking, training and certification titles. 
Both new and experienced users will benefit from these publications. For current Cisco 
Press titles and other information, go to Cisco Press at this URL: 
 
http://www.ciscopress.com 
 
Packet magazine is the Cisco Systems technical user magazine for maximizing Internet 
and networking investments. Each quarter, Packet delivers coverage of the latest 
industry trends, technology breakthroughs, and Cisco products and solutions, as well as 
network deployment and troubleshooting tips, configuration examples, customer case 
studies, certification and training information, and links to scores of in-depth online 
resources. You can access Packet magazine at this URL: 
 
http://www.cisco.com/packet 
 
iQ Magazine is the quarterly publication from Cisco Systems designed to help growing 
companies learn how they can use technology to increase revenue, streamline their 
business, and expand services. The publication identifies the challenges facing these 
companies and the technologies to help solve them, using real-world case studies and 
business strategies to help readers make sound technology investment decisions. You 
can access iQ Magazine at this URL: 
 
http://www.cisco.com/go/iqmagazine 
 
Internet Protocol Journal is a quarterly journal published by Cisco Systems for 
engineering professionals involved in designing, developing, and operating public and 
private internets and intranets. You can access the Internet Protocol Journal at this URL: 
 
http://www.cisco.com/ipj 
 
World-class networking training is available from Cisco. You can view current offerings at 
this URL:  
 
http://www.cisco.com/en/US/learning/index.html 
 
 

 
 
 



2-1 

 Unified CallConnector 
Server Overview 

 
 
 
 
 
 
This chapter provides an overview of the Cisco Unified CallConnector Server and the 
CallConnector solution. It describes the key features, the different modes of operations. It 
also describes each of the graphical user interface components of the  Unified 
CallConnector. 
 

This chapter describes the following in more detail: 
 
Key Features - Describes the key features of the Unified CallConnector.  

CallConnector Models - The CallConnector supports a standalone, server and 
mobility components. This section describes these UCC 
models. 

CallConnector Personal - Provides an overview of the features of the Unified 
CallConnector Personal model. 

CallConnector Server - Provides an overview of the additional features available 
from the Unified CallConnector Server model. 

CallConnector Mobility - Provides an overview of the features available from the 
Unified CallConnector Mobility. 

CallConnector Toolbars -        Describes the components of the Unified CallConnector 
Toolbars in Microsoft Explorer and Outlook. 

 CallConnector Sidebar/View - Describes the components of the Unified CallConnector 
Sidebars in Microsoft Explorer and View windows in 
Outlook. 

Popup - Describes the Popup applications and its menu. 

QuickSearch - Describes the QuickSearch user interface. 

Monitoring Presence Status- Briefly describes the Presence capabilities of the Unified 
CallConnector. 

Getting Help - Describes how to get Unified CallConnector help 
information. 
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Unified CallConnector Overview 
Cisco Unified CallConnector delivers a new way to handle the everyday task of 
communicating with others within the business or with customers and vendors. As a fully 
integrated communication management solution with presence (your current availability), 
you will find greater productivity and business efficiency leveraging your PC-based data 
to initiate voice, messaging or collaboration sessions. Cisco Unified CallConnector is not 
just another application for the Windows, but is embedded within your line of business 
application such as Microsoft Outlook and Internet Explorer.  
 
 
The Cisco Unified CallConnector offers these features: 
 

 Simple to use toolbar within Microsoft Outlook and Internet Explorer for 
dialing numbers, controlling the call, and setting your availability and location 
status.  

 Brings together all your contacts (personal, corporate, and Outlook) for 
QuickDialing or for starting a new email or Instant Message to the contact. 

 Quick Search feature to find a contact quickly with display of all contact 
numbers and messaging methods plus location and availability for fellow 
employees without leaving your current application. 

 Quick Message, an Instant Messaging Client included for short 
communications with fellow employees.   

 Screen pop for placed and received calls with Outlook contact name allowing 
clickable options to take the call, send the call to voice mail or send a quick 
message. 

 Quick Dialing from any application, including web pages,  by highlighting a 
number, and selecting dial. 

 Quick Presence conveniently displays availability, location and notes for 
contacts in directories and search results. 

 Optional MobilityConnector add-on providing Single Number Reach call 
routing services to allow your business calls to reach you at any number 
based on the rules you have set. 

Unified CallConnector Models 
Cisco Unified CallConnector is available in three configurations: 
 

Personal  Delivering call control features for the individual user using 
Cisco’s Unified Communications Manager Express (Cisco 
Unified CME) TAPI TSP.  

Server    Server based application installed at each site giving users call 
control plus Presence/Instant Messaging and Rules-based 
Automation Services based on a SIP Client Server architecture.  

Mobility    Add-on to the server application, the Unified CallConnector 
Mobility provides single number reach to a number. 
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Unified CallConnector Personal 
Cisco Unified CallConnector Personal is a separate install on each Windows workstation 
with a Cisco Unified IP Phone connected to Cisco Unified CME router. Each user of 
Cisco Unified CallConnector Personal delivers the call control features listed in the table 
below and is supported with any PC running Microsoft Windows.. 
 
  Features with Cisco Unified CallConnector Personal 

Unified 
CallConnector 
Personal Feature  

Description Benefit 

Call Control toolbars 
within Microsoft 
Outlook and Internet 
Explorer 

Toolbars for easy access to features 
without the need for any additional 
desktop applications. Can be used 
within Outlook or Internet Explorer 

Provides easy to use features such as 
finding contacts, executing phone 
features, and streamlining 
communications for the user 

CallConnector 
Contacts 

Within Outlook & Internet Explorer 
brings together all personal, 
corporate and Outlook contacts, 
history of calls and speed dial lists.   

Makes it easy to find contacts, view 
missed calls from your everyday 
applications  

QuickConnect from 
any Contact 

Easy click-to-dial or click-to-send on 
any contact with option to show all 
numbers (Work, Cell, Home) and 
send addresses (email, IM, SMS) 
associated with the Contact  

Saves time where call is placed in a 
few seconds without manual dialing a 
number or starting other 
communication sessions.   

Quick Transfer /Hold 
/Conference 

Easily transfer, hold or setup 
conferences using context menus 
within Outlook or Explorer.  

Ease of transferring or setting up 
conference calls using PC Mouse. 
Callback from email or conference to a 
number in the web page. 

QuickSearch though 
Contacts 

Use pause/break key on PC to 
quickly find contact and then quick 
dial number, or send email.  

Easy way to search though all contacts 
without opening new applications or 
switching pages.  

Speed dial Option to create Icon based speed 
dials for frequently called numbers. 

Common numbers are easy to find and 
dial quickly. 

Call Popup with 
Outlook Caller ID 
Lookup 

Incoming calls will show a screen 
pop with callers name lookup from 
Outlook contacts. Clickable Option to 
answer or send call to voice mail. 

Always know who is calling with option 
to answer call or ignore and send to 
voice mail.  

QuickDial from any 
application 

Highlight a phone number in any 
application like Microsoft Word, 
PowerPoint, Email or web page, then 
double-click phone icon to place call. 

Quick and easy way to place a call 
without reading number and manually 
dialing. Saves time, and improves 
productivity 

CallConnector Call 
Logs  

Missed, Received, and Dialed calls 
stored on PC in addition to the IP 
Phone. Use Quick Dial to return calls 
missed while out of the office 

Save time returning calls missed while 
away from the office. History log of 
calls received and placed can be used 
for billing. 
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Cisco Unified CallConnector Server 
The Cisco Unified CallConnector Server application delivers the features as described 
above with the added benefit of Presence and Instant Messaging. The Cisco Unified 
CallConnector Server gives your employee’s information about colleagues location, 
availability, and phone status using the same CallConnector toolbars from within Outlook 
and Internet Explorer. Using simple icons and colors to show location and availability, 
users are able to reach colleagues quickly the first time and reduce phone tag – helping 
them to be more productive.  
 
The table below lists the additional features available with Cisco Unified CallConnector 
Server.  
 
Cisco Unified CallConnector brings together easy to use call control, presence, instant 
messaging, directories and call routing rules to simplify the communication experience, 
helping work teams and colleagues share information faster and communicate in real 
time. 
 
Cisco Unified CallConnector provides status of co-workers if available or busy before 
trying to contact them. Similar to popular instant messaging status, the user can set his or 
her status from the Cisco Unified CallConnector toolbar. This status information is 
updated automatically to all users from the Cisco Unified CallConnector Server and can 
be accessed from the toolbars in Internet Explorer, Outlook or Quick search results 
window. By seeing who is online, offline, available, or busy or with custom message like 
"on vacation" or "in a meeting" can also be shared to let users know why someone is 
unavailable or busy. Knowing whether contacts are available helps to reduce 
communication delays between workers, thereby enabling faster decision making and 
enhanced productivity.  
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Features with Cisco Unified CallConnector Server 

 
Unified 
CallConnector 
Server Feature  

Description Benefit 

Dynamic Presence 
Information 

Real Time display of users Location, 
Availability, IP Phone Status, plus 
optional custom message.  

Reduces phone tag, and gives 
employee’s information of who is in 
the office or on the road. 

User Selectable 
Location  

User can set their location shown by 
Icon (Work, Home, Travel, Vacation) 
or custom message displayed to 
other users. 

Allows others (including operator) to 
see who is in office, out to lunch or 
away on travel.  

User Selectable 
Availability 

User can set their status shown by 
color, Available, Busy, Away, other.  

Lets fellow employee’s know who is 
available to receive calls or Instant 
Messages 

Dynamic IP Phone 
Status 

All phones Connected to the Cisco 
Unified CME router have status auto 
updated for others to see. 

Reduces phone tag providing more 
efficient communications 

QuickMessaging Simple Instant Messaging for the 
Small Office launched though 
CallConnector Contacts Quick Dial. 
Option to launch other IM clients 
installed on PC though Contacts 
Quick Dial. 

Easy to use Instant Messaging Client 
for productivity gains between 
employees. Alternative to use of 
external public IM Clients due to 
security concerns 

Synchronization with 
Calendar 

Updates your availability status 
automatically based on your Outlook 
calendar. 

Automatically tracks your schedule 
and reduces the need to manually 
update availability. 

QuickSearch with 
Presence information 

Quick Search results bar shows 
Location, Availability and Phone 
Status for colleagues in addition to 
contact numbers.  

Quickly find phone numbers for 
colleagues plus presence info to know 
if available before calling.  

User Customizable 
Automation Rules 

 

Set rules for basic call handling and 
notification though email or SMS 
when calls are received 

Gives users option to send notification 
to pager, cellular or smartphones 
about important calls missed while 
away from the office. 

Operator or Admin 
can change Location 
or Availability of 
others 

Gives key personal option to change 
presence information shown to 
others 

Provides up to date information to 
users to improve communications.  

Easy Install without 
configuring TAPI TSP 
at each Workstation 

Users receive email invite with 
clickable link for easy install from 
Server 

Users are able to self-install for 
reduced installation costs  
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Cisco Unified CallConnector Mobility 
Cisco Unified CallConnector Mobility brings the business calls to the workers at their 
current location and to a phone of their choice.  An optional part of the Cisco® Unified 
CallConnector family of products, the CallConnector Mobility is an add-on server 
application that integrates with Cisco Unified CME router to monitor incoming business 
calls and then route or bridge them based on user-specified call handling rules. Whether 
at home or from remote locations, the workers can place or receive calls through the 
Cisco Unified CME router and leverage the business’s Unified Communications 
infrastructure. 
 
Cisco Unified CallConnector Rules Interface allows the workers to setup automation rules 
to bring the business calls to them based on their availability and location. 
 

 
 
The Cisco Unified CallConnector Mobility is an add-on application to the Cisco Unified 
CallConnector for Microsoft Office Server. The solution monitors user’s presence status 
(availability and location) and calls placed to their Cisco Unified IP phone. Users can 
associate rules with their presence status and location to route selected callers to a 
specified number, like a cell phone. As an option, calls can be bridged to both the IP 
Phone and the remote phone. When a call is bridged, it appears both at the user’s IP 
Phone and the other phone allowing the call to be taken at either device. Calls routed to a 
remote phone are announced to the user who is given a choice to accept the call or send 
the caller to voice mail.  
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The Cisco Unified CallConnector Mobility offers the following features: 

Single Number Reach 
Cisco Unified CME router users can now provide a single phone number to their business 
contacts and be immediately connected to their business calls at the most convenient 
and available telephone. Callers can be routed to a home phone if tele-working or the 
mobile phone when in transit or any other accessible phone. With the Cisco Unified 
CallConnector Mobility, workers can provide more responsive service to customers 
without having to distribute multiple and private mobile phone numbers. . 

Single Voicemail Box 
If the user is unreachable at their specified single business number, the Cisco Unified 
CallConnector Mobility will forward the call to voice mail, using Cisco Unity Express or 
Cisco Unity. When calls are routed, an SMS (text message) or email can automatically 
send notification of the missed call to the user. The single voice mailbox allows the user 
to easily manage all business voice messages saving time and money. 

User Customizable Rules for Routing 
The Cisco Unified CallConnector Mobility is fully integrated with the Cisco Unified 
CallConnector toolbars to allow users to setup rules based on availability and location  to 
specify the reach numbers and routing for business calls. Rules can be easily changed 
from everyday used business applications like Internet Explorer and Microsoft Outlook. 
The Cisco Unified CallConnector Mobility combines the power of Single Number Reach 
with user settable routing rules to provide a flexible and user controlled solution for the 
mobile workers. 

Integration with Presence 
Call handling automation rules can be based on the presence status of the user, where 
as the status changes, call routing rules are triggered automatically. The Cisco Unified 
CallConnector for Microsoft Office allows users to change both availability (available, 
busy, away, unavailable) and location (work, home, on-the-road, etc), which can also set 
call routing rules. Using location information, the Cisco Unified CallConnector Mobility will 
know if the user is at home and available, can route business calls to their home number, 
but when busy the call is sent to voice mail with notification to the user. 

Reach At Any Phone  
The user can specify any telephone number as their single number reach telephone. This 
can be the home phone, the mobile phone or the telephone at their current location. The 
different reach numbers can be specified for their different presence locations settings.  

Validated Delivery  
The Cisco Unified CallConnector Mobility verifies the user at the reach number using a 
password to ensure that the business calls are delivered only to the user. The users can 
set their own access passwords. 

Device Switching without Interrupting Calls 
With Cisco Unified CallConnector Mobility, single number reach calls can be bridged on 
the IP Phone to allow mobile workers to continue the call after they arrive at the office 
and take advantage of speakerphone or other IP phone services. The call can be 
continued at either device without interruption, and users can use the best available IP 
Phone or mobile device. 
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Benefits of Cisco Unified CallConnector Mobility  

 
Cisco Unified 
CallConnector 
Mobility Feature  

Description  Benefit  

Simultaneous 
Ringing 

The incoming call rings on the 
Cisco Unified IP Phone and the 
user specified number. 

Call rings at both the Cisco Unified IP 
Phone and mobile phone. The call can 
be picked up at either device. 

Bridged Calls In bridged single number calls, 
the incoming call is available on 
both the Cisco Unified IP Phone 
and the remote telephone.  

This allows users to walk into the office 
and switch the call from the mobile 
phone to the Cisco Unified IP Phone.   

Routed Calls In routed single number calls, the 
incoming call is transferred to the  
remote telephone. 

User never misses important calls and 
customers are connected instead of 
going to voice mail.  

Validated User Users need to enter a password 
before the call is delivered to the 
remote telephone. 

The business calls are always delivered 
to the user. If someone else answers, 
then the call is sent to voice mail. 

Single Voice 
Mailbox 

If the user is not available then 
the call is routed to the business 
voice mail box. 

User needs to manage only one voice 
mail box for their business calls. Less 
time is needed for users to check 
multiple voicemail systems 

User-customizable 
automation rules  

Users can set rules for single 
number reach call handling. 

User’s setup their own rules for filtering 
and routing calls to their reach number. 
Different reach numbers can be set 
based on availability. 

Integration with 
Presence and 
Location 

Allows the automation rules to be 
triggered based on the current 
user availability and location. 

As the user’s availability and location 
changes, the calls can follow them to the 
most appropriate telephone device. 

Switching between 
telephone devices  

Allows the call to be switched 
from mobile to the Cisco Unified 
IP Phone and visa versa. 

Based on the needs of the moment, 
users can take advantage of the 
reliability of the wired office phone or the 
convenience of the mobile phone. 

Privacy for bridged 
calls 

When the call is bridged, it 
cannot be picked up from the 
associated desktop phone. 

Access to the call from the desktop is 
allowed as soon as the remote 
connection becomes active. This 
prevents the possibility of an 
unauthorized person listening in on that 
call. 
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CallConnector Toolbar Overview 
The CallConnector toolbar runs within Microsoft Internet  Explorer and Outlook and 
provides a unified one-click access to call handling, ability to quickly locate your contacts, 
initiate messaging and collaboration sessions. The Contacts button allows you to open 
information windows for viewing contacts, call logs or the presence status of your 
colleagues. 

CallConnector Toolbar in Outlook 

 
1. Cisco Icon/About Menu provides access to Help and links to more information on the Unified 

CallConnector and access to support and problem reporting resources. 

2. Availability:  Allows you to set your current availability status and publish it to your colleagues.  

3. Location: Lets you change your current location and indicate whether you are at work or 
away on business. 

4. Search Bar: Enter number to make a call or enter text to search for a contact. The pull down 
list lets you view the last numbers dialed or contacts located. 

5. CallControl Buttons: You can control the call on your phone from these buttons. The buttons 
are context sensitive and change with the different call states. 

Idle State: The Idle toolbar allows you to dial a new call, pickup a ringing or held call and 
forward your line to another number. 
Ringing State: For an incoming call, you can only answer the call. 
Connected State: The CallControl buttons change to provide Transfer, Conference, Hold, 
Hang-up and Park options. 
Held State: When a call is on hold, you can resume the conversation. 
 

6. Line Display Menu: The line display is a pull down list showing you the state of  the ‘lines’ or 
extensions configured on your phone. For each line, it displays the extension number, the call 
state and the calling party information. 

7. Telephony Features Menu: This provides a list of all the supported telephony features. 

8. Action Menu: The Action menu is a contextual menu providing access to the additional 
contact numbers, collaboration and communication methods for the currently active caller. 
The menu is populated with the caller’s contact details. 

9. Contacts Button: The Contacts button opens a side window in Outlook and Explorer. These 
provide access to directories, logs, presence and availability status of the users,  

Note: The Internet Explorer has two additional buttons:  

Speed Dial Menu: Pull-down arrow to the right of the dial button displays the speed dial names. 

Highlighter: Before the Contacts button allows you to convert telephone numbers in the Web 
pages to clickable numbers. 

1       2       3            4                                     5                                           6                                    7                 8                9            
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Handling Calls Using the Toolbar 
The CallConnector Toolbar allows you to control the calls on you IP Phone from your PC 
using the mouse and keyboard. You have access to most of the telephone features 
available on you phone, but now  they are integrated with your PC based data and 
accessed from a graphical interface. 
 
IDLE STATE: 

 
INCOMING STATE: 

 
 
 

CONNECTED STATE: 
 

 
HELD STATE:  

 
 
 

Locating Contacts from the Toolbar 
You can quickly locate and setup communication sessions with your contacts using the 
Toolbar QuickSearch. Communication options include making calls to work or mobile 
numbers, launching Email, SMS or Instant Message or opening up collaboration 
sessions.  
 
QUICKSEARCH BAR  
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Accessing CallConnector Applications 
The Unified CallConnector provides a suite of contact and presence management 
applications that are available from within Internet Explorer and Outlook. The figure below 
shows the CallConnector applications in Outlook. 
 

Managing Contacts  
The CallConnector supports three contact databases – Corporate for shared organization 
contact information, Personal available for each individual user and the Outlook contacts. 
The Contacts window allows you to search, view and manage this information. 
 
 

 

 

 

 

 

 



Chapter 2  Overview 
 

 

2-12  Cisco Unified CallConnector Server 

Viewing Call Log  
The Unified CallConnector Call Logs displays all a list of all calls made and received from 
your UCC program. It allows you to view important information about phone calls and lets 
you quickly search calls with specific attributes. It also allows you to perform telephony 
actions from the right-click action menu. The Call Logs also allows you to sort your call 
logs by date/time, name, number, and call type. You may also view each type of call 
individually. 
 
The Call Log window displays the history of the calls that have been made to or from your 
phone.  

Call Log Window showing history of all user’s calls 
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Call Control Buttons: 
Button Description 
Answer Answers a ringing call 
Busy Activates the Do-Not-

Disturb phone 
settings 

Hang 
Up 

Disconnects the call 

Hold Places the call on 
hold 

Resume Re-connects the held 
call 

Call Popup Window 
The CallConnector Popup Window displays information on the calls at your phone. Each 
call is represented by one window.  The Popup looks up the phone number in your 
contact database or Outlook and displays the name and organization information. The 
Popup window provides two call control buttons and the blue arrow for the Action menu. 
 
 
 
               Action 
 Menu 
 
 
                                                                                                
 
 
 
 
 
 
 
 
 
 
 
 

Using QuickSearch 
From within any application, you can quickly locate and setup communication sessions 
with your contacts using QuickSearch. Communication options include making calls to 
work or mobile numbers, launching Email, SMS or Instant Message windows or opening 
up collaboration sessions. To use enter the first few letters of the first name. 
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Monitoring Presence Status  
The CallConnector Presence Service collects information about a user's availability and 
location, including whether or not they are using their telephone at a particular time. This 
information is made available to the CallConnector users from within their every day 
business applications such as Internet Explorer or Outlook. The presence information is 
also displayed when you use the CallConnector QuickSearch to locate contacts. Using 
this real-time presence information, users can connect with colleagues more efficiently 
through determining the most effective method for communicating with them at that time 
thus avoiding phone or message tag. 
 
The CallConnector Status window provides a real-time view of the entire organization 
with information on the availability of users and groups, location of people and whether 
they are on call.  User’s can manage their own presence status, make calls and send 
instant messages from this window. 
 

Updating Availability  
The CallConnector maintains three components of a user’s presence information: 
Availability – this is the user’s current Busy, Available, Away and Unavailable status; 
Location – the place where the user is situated and the Away Message – providing 
additional notes on their availability.  In the server configuration, this information is 
broadcast to the CallConnector subscribers. 
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Availability 
Icon 

Description Location Icon Description 

 
Available 

 
At Work 

 
Busy 

 
Currently at Home 

 
Away 

 
On the Road 

 
Unavailable 

 
Away on Vacation 

 
Don’t show my status 

 
Location undefined 

 

Sending Instant Messages  
Instant messaging in the workplace can allow you to quickly resolve a question or 
communicate without interrupting the work flow. With the Unified CallConnector Server, 
users can send brief Instant Messages and Text (SMS) messages to their colleagues. 
 

 

 
  Instant Message and Text (SMS) Message Windows 
 



Chapter 2  Overview 
 

 

2-16  Cisco Unified CallConnector Server 

Outlook Menu Extensions  
Some of the Outlook menu have been extended to add in the user contact information 
and telephony action choices. These menus are described in this section.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Getting Help 
To get help on the operation of the Unified CallConnector client, click on the Cisco icon 
on the toolbars and select Help. This will display a CallConnector Help window form 
which you can browse and search to locate the topic of interest. 
 
For more information on the Unified CallConnector you can also go to the Cisco web site 
at: 
 
 
 http://www.cisco.com/go/unifiedcallconnector 
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 Installing Server Software 
 
 
 
 
 
 

This chapter describes the steps for downloading and installing the Unified CallConnector 
Server software components. It includes the steps for both the Cisco Unified 
CallConnector Server (UCC Server) and Cisco Unified CallConnector Mobility Service 
(UCC Mobility). The following topics are discussed: 

 

Installation Overview - Provides an overview of the Unified CallConnector 
Server installation process. 

Pre-requisites for Installation -Describes the information you need to have on hand 
during the installation of  Unified CallConnector Server. 

System Requirements - The minimum requirements for the server computer for 
different user configurations.   

Download Site - Site from which the Unified CallConnector software can 
be downloaded.  

Installing the UCC Server Describes the steps and options for installing UCC 
Server components. 

Installing the UCC Mobility Describes the steps and options for installing UCC 
Mobility components. 

Registering the Software - The Unified CallConnector software has to be registered 
before it can be used. This describes the options 
presented to you during this process. 

Performing an Upgrading Describes the steps for upgrading an existing Unified 
CallConnector with a new install program. 

Removing the UCC Server   This section describes the steps for removing and un-
installing the Unified CallConnector Server and all its 
components. 

. 
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Chapter 3 Server Installation 

Unified CallConnector Server Installation 
 
The Unified CallConnector Server software is installed on a Windows computer to 
provide shared access to call control, contact data and presence status for the Unified 
CallConnector users. The server installation program checks your system configuration, 
copies the software to the hard disk and makes the required configuration settings for 
you. This installation program can be downloaded from the Cisco site and run as 
described in the sections below. 
 
The installation of the Unified CallConnector Server software involves the following steps: 
 

 Collecting the information required for obtaining and configuring the Unified 
CallConnector. This includes obtaining access to the download site or the 
installation program and the information that you will require during the 
installation process. See the Pre-requisites for Installation section below for 
these parameters. 

 Preparing a Windows computer system on which you will install the Unified 
CallConnector server software. See Minimum System Requirements for the 
Unified CallConnector Server in the sections below. 

 Configuring the Cisco Unified CME IP Phone and RADIUS parameters. You 
will also need to have an account name and password for a telnet access to 
the Cisco Unified CME for downloading the phone configurations. 

 Acquiring the Unified CallConnector Server installation program. This can be 
downloaded from the Cisco Software Download Site or obtained from your 
Cisco channel partner. 

 Logging into the Windows server computer with an administrative or power 
user account. This is required to register and run the server software. 

 Running the Unified CallConnector Server installation on the computer, and 
entering the configuration information requested by the installation wizard. 

 Registering your Unified CallConnector Server with the Cisco Activation 
server. NOTE: This requires access to the Internet. 

 Setting up the Unified CallConnector Server configuration parameters from 
the Server Configuration wizard. 

 Start the Unified CallConnector Server software and verifying that the 
services start up and run. 

 Verifying that the users are able to log in and access the Unified 
CallConnector services. 

 
The Unified CallConnector Server installation software is available in several models to 
support the different product bundles such as the UCC Server and UCC Mobility. Please 
check the Unified CallConnector web site for the most current information. 
 
This chapter describes the steps for installing and activating the UCC Server software. 
The next two chapters cover the configuration and setup of the UCC Server and the 
required settings on the Cisco Unified CME. 
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Pre-Requisites for Server Installation 
As a part of the installation of the UCC Server, you need to have certain network 
connectivity and configuration information. These are summarized in the table below and 
described in the following paragraphs. 

 

Item Description Source 

Access to Download Site or 
Installation Software 

Download or otherwise obtain the Unified 
CallConnector installation program 

Service Provider or 
Sys-Admin 

UCC Server Serial Number Licensed version of the Unified CallConnector 
Server requires a serial number. You can get 
started with an evaluation version if you do 
not have a serial number. 

Service Provider or 
Sys-Admin 

UCC Mobility Serial 
Number 

Licensed version of the Unified CallConnector 
Mobility Service requires an additional serial 
number. You can get started with an 
evaluation version if you do not have a serial 
number. (This is only required for the 
installation with the Mobility Service) 

Service Provider or 
Sys-Admin 

Admin or Power User 
Name and Password 

Login access to the Windows PC on which the 
UCC Server software ins to be run. 

Sys-Admin 

Internet Access Internet access is required for registering the 
UCC Server. This can be a direct access or 
through a Proxy server. 

Sys-Admin 

 
Table 3.1 Pre-requisite information for installing the Unified CallConnector Server 

 

Access to Download Site: The installation files can be downloaded from the Cisco 
software download site. You will need a Cisco CCO account to download this software. 
You can also obtain a copy of the installation files from the Cisco solution partner. 
   
UCC Server Serial Number: The Unified CallConnector Server software requires serial 
number to operate. This serial number is provided to you when you purchase the 
software. There is an evaluation option for a limited time period that can be a started by 
entering ‘trial’ in the serial number field during the installation process. 
 
Additional UCC Serial Number: Additional UCC Server components are licensed and 
require their own serial number to operate beyond the evaluation period. These serial 
numbers are provided to you when you purchase the software. The additional server 
components also support the evaluation option that can be a started by entering ‘trial’ in 
the serial number field during the installation process or in the Configuration Wizard. 
 

Admin or Power User Account of Installation PC: The installation program requires 
access to Windows registry and installation of services. These changes can only be 
performed with an account with admin or power user rights to the Window’s computer. 

Internet Access: The CallConnector Server software has to be registered to the Unified 
CallConnector License Server via an activation process. This requires access to the 
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Internet. The Internet access can be through a Proxy Server. In this case the Internet 
Explorer on the PC should have the proxy settings defined. 

Windows Access Rights: 
During the installation of the Unified CallConnector, you need to have local admin rights 
to the personal computer. This is to allow various system files to be loaded and Windows 
registry entries to be written. 
 
Note: If you are not logged in to the PC with the required access rights, the installation 
may fail or not run through completion. 

Minimum System Requirements 
Your system must meet the minimum system requirements described in this section. We 
recommend that your system exceed the minimum when possible to ensure better 
performance. 

Computer and Windows OS 
The table specifies the minimum computer requirements for three different size systems. 
The system requirements vary depending on the number of users logged on to the UCC 
Server. The number of users here refers to the number of concurrently logged on Unified 
CallConnector clients.  
 
These are minimum requirements and deal with only the Unified CallConnector Server 
requirements. If the computer is running other application or services, those requirements 
should be added to these specifications. 

 
 25 User System 75 User System 250 User System 

Processor Pentium PC 2Ghz Pentium Dual Core 
3Ghz or Greater 

Pentium Quad Core 
3Ghz or greater 

Memory (RAM) 1 Gbyte RAM with 350 
Mbyte available for UCC 
Server 

2 Gbyte RAM with 1 
Gbyte available for 
UCC Server 

4 Gbyte RAM with 2 
Gbyte available for 
UCC Server 

Operating 
System 

Microsoft Windows XP 
Professional Service 
Pack 2 or Microsoft 
Windows 2003 Server 

Microsoft Windows 
2003 Server 

Microsoft Windows 
2003 Server 

Disk Space 200 Mbyte available for 
UCC Server 

400 Mbyte available 
for UCC Server 

800 Mbyte available 
for UCC Server 

 
Table 3.2 Recommended minimum computer system for the Unified CallConnector 
Server 
 
Note:  Available memory in the computer can be determined by opening the Windows 
Task Manager to the performance tab and viewing the used and available before running 
the UCC Server. 
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Application Software 
Unified CallConnector Server uses the settings of the of Internet Explorer for navigating 
through proxies servers. If you are using a Proxy server to access the Internet, first verify 
the connection using the IE browser. 

 Internet Explorer Version 6.0 with Service Pack 2 

Telephone System 

Communication Systems 
The UCC Server provides shared access to telephony service to the UCC clients. The 
UCC Server supports the following Cisco Systems communication systems. For a more 
current list, see the data sheets on http://www.go.cisco.com/unifiedcallconnector/ 
 

 Cisco Unified Communications Manager Express 4.1 or higher. 

 Unified Communication 500 

Connecting to multiple Communication Systems: 
The Unified CallConnector Server can be connected to multiple Cisco Unified CME 
systems.  The number of systems that can be connected is dependent on the network 
connecting the systems, the number of users in each system and the capacity of the 
computer system hosting the Unified CallConnector Server. Please consult with your 
Cisco System Engineering resource or channel partner for your specific configuration 
needs. 

IP Phones: 
The Unified CallConnector Server can connect to and control the following Cisco IP 
Phones: 
 

 7970, 7971  

 7960, 7961 

 7940, 7941 

 7920, 7921 

 IP Communicator Softphone 

LAN Access and Ports 
The Local Area Network is used in multi-user environments to share the directory data 
and to access services such as E-mail and the Telephony Service. Access to the Internet 
is also required for the activation process. 

The following network connections are made between the applications running on the 
Unified CallConnector Server and the Unified CallConnector clients and the Unified 
Communication Systems: 
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Connections to: Type Server Ports (Default) 

Communication Servers – SCCP TCP Available TCP ports 

Communication Server – RADIUS UDP 1646 

Communication Server – Telnet TCP 23 

UCC Server Application UDP + TCP 5060, 39984, 5061, 5062, 5063, 
5071 

UCC Mobility Service UDP + TCP 5072- 5077 

UCC Clients Receive Port  TCP 5065 

Server Wizard (to verify activation) TCP 80 

Email (SMTP Server) TCP 25 
 
Table 3.3  TCP/UDP Ports used by the Unified CallConnector Server 
 

Download Site 
The Cisco Unified CallConnector can be downloaded and installed from the Web. Go to 
the link below, select the Unified CallConnector for Microsoft Windows, and download the 
installation files.  
 
<http://www.cisco.com/cgi-bin/tablebuild.pl/callconnector-ms>  

 
Note: A valid CCO User ID and Support Contract is required to access the software 
download center. If you don't have access, contact your Cisco reseller. 
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Installing the Unified CallConnector Servers 
The installation process is the same for the different models of the Unified CallConnector 

Server applications.  

During the installation process, the Unified CallConnector Server install program will 
check your system’s components and determine what files need to be upgraded. It will 
copy program files to an installation folder of your choice and system files to the Windows 
System directory. 

 

The installation program also sets up the Unified CallController Server applications to run 
as Windows Services. 

Step 1: Download the Installation Program 
Log in to the Cisco Software Download site for the Unified CallConnector and download 
the latest Unified CallConnector client installation program. You can also obtain this from 
your Cisco Channel Partner. 

Step 2: Run the Unified CallConnector Installation 
 
Login to Windows under Admin account: The installation program writes to the 
Windows registry and requires access rights available under the administrative account. 
 
Close all Windows Applications: Close all open applications. Disable the screen-saver 
if the PC has one enabled. 
 
To Install Unified CallConnector Server:  Launch the Unified CallConnector Server 
install program by double-clicking on it. 
 
Once the install program is loaded, it will present the Welcome dialog. 
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Click on Next to display the Software License Agreement statement. 
 
Please read the Software License Agreement statement and click on Yes to accept the 
license and Next button for the Customer Information window. 
 

 
 

User Name: The name of person under which the software will be registered. 

Company Name: The name of registering person company or organization. 

Email: The email address of the registering person. 

Serial Number: Each instance of the Unified CallConnector software is enabled 
with a unique serial number. This serial number is provided to you with your 
purchase packet or sent you to you via email. If you do not have a serial 
number and wish to evaluate the Unified CallConnector for a limited time 
period, then enter ‘TRIAL’ in the Serial Number field. Note do not enter the 
single quotes. 

Language: This option selects the graphical and telephone user interface 
language from the available languages. Note: Currently this selects the 
prompting language. Language options include several languages in male 
and female voices and a Custom selection. The Custom Selection is to allow 
you record your own prompt files. 

  

 To create your own prompt files: 
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 Record your audio prompts. These must be in the supported audio file 
format. The file names must exactly match the files required by the 
application.  

 
The email address and the serial number will be required if you need support related to 
the license activation. Please note the information below for your record. 
 
Registration Email Address: __________________________________________ 
 
UCC Server Serial Number: __________________________________________ 
 
Note: The UCC Mobility Serial Number is entered through the configuration wizard. 

To proceed: 
 
Enter your name, company and the software serial number. Click Next or press the 
ENTER key.  

Program Files Location: 
The next window allows you to specify the location to which the Unified CallConnector 
program files will be copied. Click on the Browse button to select a folder other than the 
default. 
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To Proceed with the installation: 
 

 Choose the default program path or click on the Browse button and specify 
the desired path.  

 Click on Next to the proceed with the installation. 
 
The installation will copy the program and system files and update the registry and XML 
configuration file settings.  
 
Once the files have been copied, it will launch the Unified CallConnector Server Setup 
Wizard to allow you to activate the serial number for the server. 
 
Note: You will need to restart the computer once the activation has been completed to 
apply the registry updates. 
 

Registering the Unified CallConnector Server 
 
All installations of the Unified CallConnector need to be activated with the Cisco Unified 
CallConnector Licensing Server. Activation is a process in which the Unified 
CallConnector program sends the serial number and the installed computer information 
to the licensing server. The Licensing server verifies the serial number and saves it along 
with the computer information. 
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The activation process is initiated when the Unified CallConnector Server Wizard is run 
the first time. If the activation process is not completed successfully, then the Unified 
CallConnector Server programs will not run. The Server Wizard activation window is 
shown above. 
 
The Serial Number that you entered during the installation is displayed in the Serial 
Number field. If you entered ‘Trial’ for a limited time evaluation, then this is displayed. 
You can convert the ‘Trial’ Serial Number to a fully licensed program by entering the 
serial number in this field. 
 
If you are evaluating the Unified CallConnector Server, then the activation will obtain a 
trial-serial-number for you when you active the trail license. This will be displayed in the 
Serial Number field. 
 
During the activation process, you serial number, name, email address and certain 
machine information is sent to the licensing server. You can also enter some personal 
information and chose to send it to Cisco systems to help us understand the deployment 
of the solution. The personal information is only sent if you select the checkbox ‘Send 
optional personal information to Cisco Systems. 
 
To activate the Unified CallConnector, please make sure that you have access to the 
Internet from this personal computer and click on the Activate button.  
 
The Unified CallConnector will access the Licensing Server over the Internet and send 
the activation information. A prompt is displayed when the activation process is started. 
The results of the activation are displayed when the process is complete. 
 
Notes: 
 
If you are using the trial serial number, then the Unified CallConnector Server will need to 
access the Licensing Server every time the CallConnector Server Wizard is run. This 
requires access to the Internet. The fully licensed Unified CallConnector is activated one 
time only. 
 
You can convert from a trial to a licensed version of the Unified CallConnector Server 
from the Server Wizard Version Information window. When the trial period expires, the 
Unified CallConnector Server applications will stop working. When the Wizard is run, it 
will display the license activation window to allow you to enter a valid server license 
number. 
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Problems with Activation 
The license activation process can fail for a number of reasons. Some of these are 
discussed below. 

Cannot Access the Internet 
The activation process cannot access the Internet. Among other reasons, this can be due 
to: 
 

 Firewall blocking the Server Wizard from accessing the Internet 

 If a Proxy Server is being used, verify that the Internet can be accessed from 
the Internet Explorer. Also verify that it is a supported Proxy server. The 
activation process supports the Socks and HTTP proxy servers. The proxy 
parameters are read from the Internet Explorer Proxy server settings. 

Cannot Access the License Server 
This error indicates that the Internet is accessible but the License Server cannot be 
accessed. 
 
To verify License Server availability you can browse to the License Server site: 
 

http://www/unifiedcallconnecor.com 
 

Trial (Evaluation) Period has Expired 
The trail period for the Unified CallConnector Server on this computer has expired. You 
will to purchase a server license and run the Server Wizard to enter the new license. 
 
Note: When the trial period expires, the Unified CallConnector Server applications will 
stop operating. 

License has been Activated on Another Machine 
The serial number that you have entered is invalid and is being used on another 
computer. You will need to purchase a valid Server serial number. 

Serial Number is Invalid 
The serial number that you have entered is invalid. Check the number you have entered. 
You will need to purchase a valid Server serial number for the Server applications to 
operate. 

Activation Information has been Modified 
Once the serial number has been activated, a set of information is stored in the Windows 
registry. If this information is deleted or changed, then the activation checking will fail and 
you will need to re-activate the software. 

Trial License has been blocked 
Please contact Cisco support as the trial license has been blocked. 
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Restart the Computer: 
The installed server components are available once the computer has been restarted. 
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Performing an Upgrade 
If you want to upgrade your Unified CallController to a newer version, then you can 
download and run this later installation program. The installation program will ask you if 
you want to upgrade the Unified CallConnector files.  

 
 
Click on Yes to continue with the upgrade. Make sure that you have closed all instances 
of Internet Explorer and Outlook and the Unified CallConnector Server programs. The 
install program will then copy the newer versions of the files to your computer.  
 

 
 
The upgrade process can also make changes to the database files and will prompt you 
with a confirmation. 

 
 

 

Once the files have been copied and updated you will be asked to restart the PC. 
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Removing Unified CallConnector Server 
You can remove the Unified CallConnector and all its files from the Windows 
Add/Remove program.  
 

 From the Widows Start menu, select Settings and open the Control Panel. 

 Double click on Add/Remove Programs 

 Select Cisco Unified CallConnector Server and click on the Remove button. 

 
 
The Unified CallConnector Installation program will run. Click on the Remove button and 
then on Next. 
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The Unified CallConnector will be un-installed from your computer. 
 
The Modify and Repair options compare the versions of the files in the PC with the 
version of the files in the installation. If later versions exist, these are updated. 
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This chapter describes how to configure and setup the Unified CallConnector Server 
applications and covers the following areas. 

Configuration Overview - Describes the components and parameters that 
have to be setup for the proper operation of the 
Unified CallConnector Server components.  

Pre-requisites for 
Configuration - Describes the information you need to have on 

hand or have setup for use during the 
configuration of Unified CallConnector Server. 

Server Setup Wizard - Provides an overview and describes how to start 
and exit the Unified CallConnector Server Setup 
Wizard.  

Setting Up SIP Parameters - Describes the SIP Server configuration 
parameters and the default values. 

Database Server Setup - Describes the Database Server configuration 
parameters and the default values. 

Presence Server Setup - Describes the Presence Server and RADIUS 
server configuration parameters. 

Setting up CallController -       Describes how to setup the CallController server 
by downloading and selecting the ephones. 

Setting Automation Server -    The Automation Server can hosts a number of 
different services. In particular it supports the 
Mobility Service. This section describes the 
Automation Server configuration parameters. 

Create a List of Group-  Describes how to enter the department or 
groups for viewing in the Status window. 

Adding Users - Describes how to add, modify and delete the 
user account information for the Unified 
CallConnector users. 

Configuring User’s Phones - Describes how to associate an ephone with a 
user. 

Sending Notifications -  Describes how to send out an email notification 
to the UCC users and the different attachment 
options. 

Reporting Problems - Describes how to report any problems that you 
may be experiencing with the Unified 
CallConnector Server.  
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Server Configuration Overview 
The Unified CallConnector Server is comprised of server applications that run as services 
on a Windows computer system. Together these server applications provide call control, 
data access and presence services to the Unified CallConnector clients. In addition to the 
server applications, the Unified CallConnector Server maintains the user configuration 
data and the contact and transactional data using a database system.  
 
These Server applications connect to the Cisco Unified CME router for call control 
information and to the Unified CallConnector clients connect to the server applications. 
 
The configuration of the Unified CallConnector Server software requires a set of 
information and prior setup of the Windows platform and the Cisco Unified 
Communications Managers. The pre-requisites for the configuration are discussed in the 
next section. 
 
To setup the Unified CallConnector Server, these following aspects of configuration have 
to be completed.  
 

• Setting up the Server Application’s Communication Parameters 

• Downloading and selecting the ephones that will be controlled by the UCC 
Server 

• Setup the Automation Server parameters for the hosted automation 
applications. In the basic UCC Server, this option is disabled and not 
available for configuration. 

• Defining the organization’s groups or departments 

• Creating User account with login IDs and contact information. Assigning 
users to their groups/departments. 

• Associating ephones with the users 

• (Optionally) Sending the user’s login information via email to the allow them 
to more easily install the Unified CallConnector client. 

• Verify that the configuration parameters are correct and the server 
applications are functioning. 

 
An overview of these configuration steps are described in the following paragraphs. 

Server Application’s Communication Parameters 
Each of the Unified CallConnector Server applications need to be setup and configured to 
allow them to: 

• Communicate using SIP messages. 

• Access the functions for which they are providing services. 

• Enable the debug trace capability and debug file as needed. 

• Setup the Windows environment for these applications to run as services 
 
The configuration information is saved in Windows registry files associated with the 
server applications as well in files and databases. The first server application window 
(System SIP Server) allows you to enable the same password and debug trace levels for 
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all server applications. Note: The RADIUS password needs to be set, independently of 
the other servers. 

Communicating using SIP 
The Unified CallConnector Server applications use the Session Initiation Protocol (SIP) 
for inter-process messaging and communication. Each server application need to be 
configured with the address of the SIP Server and the port used to receive messages. 
The Unified CallConnector Servers each have a pre-defined ‘well-known’ name that is 
recognized by the SIP Server. 
 
The Server application ports are used for both UDP and TCP connections.  
 

• Default values of the ports are presented by the configuration wizard.  

• These ports must be available and not used by any other application. You 
can verify the port availability using tools such TCPView. 

• Each Unified CallConnector client setup a TCP connection to the 
CallController, Presence and Database server applications. 

• If the default ports are not available on your machine, these can be changed 
to other available ports. 

Debug Tracing 
Each of the server application supports writing trace and debug information to a log file. 
This trace function can be enabled from the Server Wizard. There are six trace levels 
defined. For each level, all the trace messages for that level and below are written to the 
log files. 
 

Critical:  Fatal error – the application will terminate. 

Error:  Defect in a feature or function. Does not affect the operation of 
the application. 

Warning: Generally indicating resources are being depleted. 

Information: Information messages for significant events in the operation of 
the application. 

Debug: Summary level trace messages to assist in debugging the 
application. 

Trace:  Verbose level trace messages for debugging the application. 
 
The debug messages are written to individual files for each server application. 
Information is written to the trace file until the maximum size setting for the trace files is 
exceeded. The current trace file is renamed to .bak and a new trace file is created. If a 
backup file exists, it is deleted. 
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Downloading Ephone Information 
The UCC Server can connect to the Cisco Unified CME ephones in two different ways – 
to control another ephone that is running independently or to connect as an IP Phone 
(softphone) to the router.  
 

Control another IP Phone 
In this configuration the ephone exists either as a IP Phone or as a softphone and the 
UCC Server connects to the router in a manner to allow the UCC Clients an ability to 
control the calls on that IP Phone. 
 
This configuration requires the ephone to be configured with a user name and password. 

Emulate an IP Phone 
When configured to emulate an IP Phone, the UCC Server itself connects to the Cisco 
Unified CME as an IP Phone. In this mode the media is terminated by the UCC Server. 
 

 
Each ephone that is to be controlled by the UCC Server has to be specified through the 
Server Configuration Wizard.  
 
The ephones parameters, which include the CME IP address, ephone MAC address, 
port, user name and password of the ephone, can be entered manually or downloaded 
from the CME. 
 
The download method uses the Telnet protocol to access the CME configuration 
information. To use this method, you will need to have a Telnet account and provide the 
user name and password to the Wizard. The Wizard downloads the parameters for all the 
ephones configured on the CME. You will then need to select the ephones that are to be 
controlled by the Unified CallConnector Server from this list. To specify ephones that are 
to be emulated, check the option ‘’Connect as Softphone’ before adding the ephone to 
the CallController Server list. 

Defining Groups/Departments 
The Unified CallConnector Presence Server displays the user grouped by their 
department in the Status window. This list of users is read from the Corporate contacts 
database. The Corporate contacts database can include users that have accounts on the 
Unified CallConnector Server and are therefore able to login. The Corporate directory can 
also contain contact information for non-UCC users.  
 
Groups/Departments should be defined using the Server Wizard. The Wizard allows you 
to add, modify and delete the Groups/Departments. The Presence Server can controll 
access to the status of the users in these groups. You can determine if the users in 
Group ‘A’ can view the status of users in group ‘B’. Access control is supported only for 
the groups defined through the Server Wizard. 

Setting up User Configuration 
In order to access the services provides by the Unified CallConnector Server 
applications, users have to be configured on the UCC Server to allow them to login. The 
user configuration creates a list of the users with their contact information and login 
names and passwords.  
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Associating Ephones with Users 
You need to associate an ephone with a user. A user can have one ephone, however an 
ephone can be shared by multiple users.  
 
The allocation of the ephone to a user is made through the Server Wizard. 

Emailing Instructions/Notification to Users 
Two types of email notification services are provided by the Unified CallConnector Setup 
Wizard: 
 

• User Notification: The administrator can send email messages to selected 
users with the Server Wizard. In this the administrator can optionally select 
additional information to be automatically insert or attached. These include  
user login name and password, attached document such as a user guide or 
attached customized configuration file to simplify the client installation. 

• Problem Report: This allows the administrator to sent a description of the 
problem being experienced with the server and attach the debug/trace log 
files to help with the problem diagnosis. 

 
The email notification service requires a pop3 email account to be available for sending 
the messages. 
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Pre-Requisites for Server Configuration 
The configuration of the Unified CallConnector Server software involves the following 
steps: 
 

• Collecting the information required for obtaining and configuring the Unified 
CallConnector Server. This includes obtaining access to the download site or 
the installation program and the information that you will require during the 
installation process. See the Pre-requisites for Installation section below for 
these parameters. 

• Preparing a Windows computer system on which you will install the Unified 
CallConnector server software. See Minimum System Requirements for the 
Unified CallConnector Server in the sections below. 

• Configuring the Cisco Unified CME IP Phone and RADIUS parameters. You 
will also need to have a user name and password for a telnet account to the 
CME for downloading the phone configurations. 

 
This chapter describes the steps for configuration and setup of the Unified CallConnector 
Server software. The next chapter cover the required settings on the Cisco Unified CME 
router. 
 
As a part of the installation of the Unified CallConnector Server, you need to have certain 
network connectivity and configuration information. These are summarized in the table 
below and described in the following paragraphs. 
 
 

Item Description Source 

UCC Server Serial Number Obtain the serial number or use ‘trail’ for a 
limited time evaluation period 

Sys Admin 

User account and contact 
information 

Obtain the user’s contact and account 
information for creating the user accounts 

Sys-Admin 

Cisco Unified CME 
Configuration 

Configure the ephones and RADIUS 
parameters on the router. 

Service Provider or 
Sys-Admin 

TCP and UDP Ports Verify that the required TCP/UDP ports are 
available on the server. 

Sys-Admin 

 
Table 3.1 Pre-requisite information for installing the Unified CallConnector Server 
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Server Setup Wizard 
The Unified CallConnector Server Setup Wizard is an application that runs on the Unified 
CallConnector Server computer and provides the graphical interface to setup the 
configuration information for the Server applications and save then in the proper 
repositories. 

Starting the Wizard 
 
The Unified CallConnector can be started from: 
 
Start Menu->Programs->Cisco Systems 
 ->Unified CallConnector Server-> Unified CallConnector Server Wizard. 
 
The Wizard allows you to step through each of the configuration screens or directly jump 
to a specific window. 

 
You can jump directly to a section by clicking on the button to the right or click on the 
Next button to navigate through all the windows. Click on Home to return to this first 
page. Information in some of the windows is written when you move to the next window. 
In other cases, the information is written when you click on the Finish button. If you click 
on Cancel or the Exit button, this information is not written. 
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NOTE:   

1. YOU NEED TO RESTART THE UCC SERVER APPLICATIONS TO APPLY 
THE  WIZARD CONFIGURATION CHANGES. 

2. IF THE AUTOMATION/MOBILITY SERVER OPTION IS DISBALED THEN 
THE INSTALLATION THAT YOU ARE RUNNING DOES NOT HAVE THE 
MOBILITY SERVICE FILES. YOU WILL NEED TO DOWNLOAD THE 
UNIFIED CALLCONNECTOR SERVER WITH MOBILITY SERVICE 
INSTALLATION PROGRAM. 
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Version Information 
 
The Version Information window displays the file version form each of the Server 
applications. It also displays the overall Unified CallConnector Server Build date and 
Version at the top right of the window. 
 

 
 
The License Serial Number can be modified from this window as described below. 

Converting from Trial to Licensed Version 
The evaluation version of the Unified CallConnector Server can be converted to a 
licensed version by entering a valid Server Serial Number. 
  
To Convert from Trial to Licensed Version: 
 

• Open the Server Setup Wizard to the Version Information page. 

• Delete the TRIAL_UCCS-xxxxxx trial serial number, enter the server serial 
number and click on update. 

• You will need to exit and restart the Setup Wizard to activate the serial 
number with the Unified CallConnector License Server. 
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Setting up System SIP Parameters 
Parameters for the System SIP Server and the System Tracker need to be setup to allow 
the Unified CallConnector server applications and clients to run properly. 

System SIP Server 
• Click on the SIP Server button in the welcome page or click Next to get to the 

System SIP Server Parameters page. 

 

• SIP Domain: Enter the IP address of the computer on which the Unified 
CallConnector Server software has been installed. The SIP Domain can also 
be a network address if that domain name has been registered with the local 
Domain Name Server (DNS). 

• Port: This is the port on which the Unified CallConnector System SIP server 
will receive messages. The default port for the System SIP Server is 5060.  

• Trace Logging: If asked by Cisco Technical Support, enable the debug trace 
logging and set the Trace level to the requested level. This option is checked 
at the server application startup, to determine if debug logging is enabled. By 
default the trace files are saved in the Trace Log folder under the Unified 
CallConnector Server. To apply this Trace Log setting to all the Server 
applications, enable the option ‘Apply debug trace log setting to all servers’. 

• Apply password to all servers: The specified password is applied to all the 
UCC Server applications avoiding the need to enter the information in each 
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of the server windows. (Note – This does not apply to the RADIUS password. 
The RADIUS password must be entered separately). 

 

Click on Next to continue. 

System Tracker Parameters 
The System Tracker polls each of the Unified CallController Server applications and 
sends Server Connected, Disconnected, Ready or Not Ready messages to the 
subscribing clients. 

 
 

• SIP Server Address: This is the IP address or network address of the 
computer with the System SIP Server. If the Unified CallConnector Server 
components are all installed on one computer, then this address will be the 
IP address of this machine. 

• Port: This is the port used by the System Tracker to receive messages. The 
default value is 5071. If this port is not available, then change this to a port 
available on the computer. 

• Username: This is the well-known name of the System Tracker. This cannot 
be changed. 

• Password: This password is used to authenticate the registration of the 
System Tracker. Enter the password. This can be any text or number string 
up to twelve characters in length. 
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• If asked by Cisco Technical Support, enable the debug trace logging and set 
the Trace level to the requested level. This option is checked at the server 
application startup, to determine if debug logs are to be written. 

Click on Next to continue. 

Database Server Parameters 
The Unified CallConnector Database Server provides access to the configuration, contact 
and transactional data to all the Unified CallConnector servers and clients. There are two 
aspects to the configuration – setting up the communication parameters to handle the 
SIP messages and setting up the access to the database system. 
 

 

SIP Communication Parameters 
• SIP Server Address: This is the IP address or network address of the 

computer with the System SIP Server. If the Unified CallConnector Server 
components are all installed on one computer, then this address will be the 
IP address of this machine. 

• Port: This is the port used by the Database Server to receive messages. The 
default value is 5061. If this port is not available, then change this to a port 
available on the computer. 
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• Username: This is the well-known name of the Database Server. This cannot 
be changed. 

• Password: This password is used to authenticate the registration of the 
Database Server. Enter the password. This can be any text or number string 
up to twelve characters in length. 

• If asked by Cisco Technical Support, enable the debug trace logging and set 
the Trace level to the requested level. By default the trace files are saved in 
the Trace Log folder under the Unified CallConnector Server. 

Click on Next to continue. 

Database System Parameters 
The Unified CallConnector supports three separate databases. These include the 
Corporate Directory Database, the Transaction Log Database and the Unified 
CallConnector Configuration Databases. 

 
The Server Installation program copies the default database files to the Data folder under 
the Unified CallConnector Server. This Wizard page allows you to select different files if 
you have these files saved or backed up in a different folder. 
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To Select Different Database files 
• Click on the Browse button for the database of interest and select the 

appropriate file. 
 
NOTE: The Unified CallConnector must use the databases and tables that have provided 
by the install program. The database structure, the tables and the fields in the tables 
cannot be changed. You may backup the database files and from the wizard select these 
backed-up database files. 

Managing the Database files 
The following data management options are provided in the Unified CallConnector 
server: 
 
Removing the Call Log Entries 
The call log entries are written to the database for every number for which there is a 
match with a Unified CallConnector user’s contact numbers. Over a period of time a large 
number of records can be written. Individual Unified CallConnector users can manually 
delete their own call log entries. This option allows you to set a policy to automatically 
delete the call log entries that are older than a certain number of days.  Three duration 
selections are available – 30, 60 or 90 days. To disable this automatic call log entry 
removal option, select the 0 days option from the pull down list. 
 
Database Backup 
The database backup option allows you to save the current database files to a backup 
folder. You should first stop the Unified CallConnector Server applications. The database 
files are copied and saved in the Databackup folder. Any existing database files in the 
backup folder are overwritten.  When you click on the Backup button, you will be 
prompted to close the server applications. 
 
Database Restore 
The database restore option allows you to copy the backed up database files to the 
current database folder. The Restore operation should only performed if there is a 
problem with the current data files. You should first stop the Unified CallConnector Server 
applications. The database files are copied from the Databackup folder to the Data folder. 
Any existing database files in the Data folder are overwritten.  When you click on the 
Restore button, you will be prompted to close the server applications. 
 
NOTE: THE DATABASE RESTORE WILL OVERWRITE THE DATABASE FILES AND 
YOU WILL LOOSE ALL THE DATA THAT CHANGED SINCE THE LAST BACKUP 
OPERATION. 
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Compact Database 
When entries are deleted in the database, they are marked as deleted but not removed 
from the database files. The Compact operation removes these deleted records form the 
database file and recovers disk space. You should first stop the Unified CallConnector 
Server applications before starting the Compact operation..  When you click on the 
Compact Database button, you will be prompted to close the server applications. 

 Select the number of days you want to retain the call log entries from the pull 
down list. Select zero if you do not want to automatically delete log entries. 

 
Click on Next to continue. 

Presence Server Setup: 
The Unified CallConnector Presence Server reads in the user configuration data and the 
corporate directory information and maintains the user’s presence and telephone status 
information. The Presence Server incorporates a Radius Accounting Server functionality 
to receive the telephone status updates from the Cisco Unified CME. The user presence 
information and telephone status is published to all authorized clients in real-time. There 
are two aspects to the configuration – setting up the communication parameters to 
handle the SIP messages and setting up the Radius parameters to allow the Presence 
Server to receive these Radius accounting messages. 

Presence Configuration Notes 
 

 The Presence Server publishes the list of users in the Corporate directory 
database grouped by their departments. 

 The Presence Server manages and publishes the presence status 
(availability and location) and the telephone status of these users in real-
time. 

 Contacts in the Corporate directory can be UCC users and non-users. A 
UCC user has a user login account created via the Server Wizard. 

 Presence status is published for both types of users. 

 Only the UCC users can update their own status; administrator’s or 
managers need to change the status of the non-UCC users. 

 Telephone status is published only if there is a match on the caller or called 
number with one of the user’s work, work-2, home or mobile numbers. 

 For the telephone numbers to match, the caller/called number and the 
numbers in the database must be in the same format – preferably in the 
canonical format.  

 Call logs are only written for the UCC users. 

 Presence Access control can only be applied to the Groups/Departments 
defined through the Server Wizard. 

 The department field in the Corporate directory can contain directory names 
that are not in the ‘Group’ list. 

 The status of the user’s in departments not in the Group list is visible to all 
the UCC users. 
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SIP Communication Parameters 
 

 SIP Server Address: This is the IP address or network address of the computer 
with the System SIP Server. 

 Port: This is the port used by the Presence Server to receive messages. The 
default value is 5062. If this port is not available, then change this to a port 
available on the computer. 

 Username: This is the well-known name of the Presence Server. This cannot be 
changed.  

 Password: This password is used to authenticate the registration of the Presence 
Server. Enter the password. This can be any text or number string up to twelve 
characters in length. 

 If asked by Cisco Technical Support, enable the debug trace logging and set the 
Trace level to the requested level. This is checked at server startup only. By 
default the trace files are saved in the Trace Log folder under the Unified 
CallConnector Server. 
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Pattern Length and Prefix 
The Presence Server tries to match the incoming caller-id to the numbers in the directory 
databases. The caller-id information received from the RADIUS messages can be 7 or 10 
digits long. The user extension numbers in the directory database can be saved either as 
extension numbers 3, 4 or 5 digits long or in the canonical format including the area code. 
If the internal extension numbers are saved in the directory in the abbreviated format, 
then the ‘Pattern or Extension Length’ and ‘Pattern or Extension Prefix’ have to be 
configured to allow the caller-id from the RADIUS messages to be correctly looked up. 
 
 
For example:  
 
The internal extension length is four digits and the caller number is 4341000. If the work 
numbers are saved in the directory as four digit numbers such as 1000 then the pattern 
length and extension have to be configured. The Pattern Length should be configured as 
4 and the Pattern Prefix should be set to 434. The Presence Server will append the prefix 
to the extension number in the directory then perform the lookup, 
 
However if the work number in the directory is saved a 434-1000 then the Pattern Length 
and prefix do not need to be configured.  
 
Click on Next to continue. 
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The next window sets up the parameters for the Radius Accounting server incorporated 
in to the Presence Server. Two parameters need to be specified for the Presence Server 
to receive the accounting packets from the Cisco Unified CME.  

 

To Set the Radius Parameters: 
 Enter the Authentication Key value. This is the password value used to 

authenticate the communication between the Cisco Unified CME and the 
Presence Server. This value must match the Radius Server Key value set in the 
Cisco Unified CME router. 

 Radius Accounting Port: The Radius Accounting Server opens this port to 
receive the accounting messages. This value must match the Radius Server 
Accounting Port value set in the Cisco Unified CME router. 

 
Click on Next to continue. 

 
NOTES:  

 See Chapter 5 – Configuration of the Cisco Unified CME router parameters for 
details of setting the RADIUS accounting messages. 

 Verify that not other Radius servers are running on the computer as they might 
block access to the default Radius accounting port. 
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 If the Unified CallConnector Server is connected to multiple CME/UC500, then 
the RADIUS password and port must be the same on all the routers. 

Setting up the CallController 
The CallController Server connects to the Cisco Unified CME router to control the user’s 
IP phones. To setup the CallController, you need to configure the following information: 

1. Specify the SIP communication parameters for the CallController Server. 

2. Obtain a list of the IP phones that are present on the Communication Cisco 
Unified CME router. This can be done manually or by using the automated 
Configuration Download feature of the Wizard. 

3. Specify or select the IP Phones that are to be controlled by the CallController 
Server. You should select only the phones that will be accessed and 
controlled by the Unified CallController users. 

4. Verify that the selected phones can be accessed and controlled by the 
CallController Server. 
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SIP Communication Parameters 
 

 SIP Server Address: This is the IP address or network address of the computer 
with the System SIP Server. 

 Port: This is the port used by the Presence Server to receive messages. The 
default value is 5063. If this port is not available, then change this to a port 
available on the computer. 

 Username: This is the well-known name of the CallController Server. This cannot 
be changed.  

 Password: This password is used to authenticate the registration of the Presence 
Server. Enter the password. This can be any text or number string up to twelve 
characters in length. 

 If asked by Cisco Technical Support, enable the debug trace logging and set the 
Trace level to the requested level. This is checked at server startup only. By 
default the trace files are saved in the Trace Log folder under the Unified 
CallConnector Server. 

 
Click on Next to continue. 

Downloading IP Phone Configuration 
This is an optional step provided to help make the installation easier. Information about 
the IP Phones that are to be controlled by the CallController Server can be entered 
manually. If the information is downloaded from the Cisco Unified CME router then you 
need to only select the required IP Phones from a list.  
 
The Wizard uses the telnet protocol to download the IP Phone information. You will need 
a telnet account on the Cisco Unified CME router for this function. 
 
To Download the Cisco Unified CME IP Phone information: 
 

 Enter the CME IP Address: This is the IP address of the Cisco Unified CME 
router. 

 Telnet User Name:  This is the login user name for the telnet command line 
access to the Cisco Unified CME router. The exec level password is not required. 

 Telnet Password: Telnet account password. 

 Click on Start. The Wizard will log in to the Cisco Unified CME  router and down 
load the IP Phone information using the ‘Show Ephone’ command. This IP Phone 
information is s saved in the cme.xml file in the Unified CallConnector Server 
folder. 

 
Click on Next to continue. 
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NOTES:  

 

1. The IP Phone configuration download does not require the privilege level access to 
the router. 

2. The Cisco Unified CME  router administrator can run the wizard and make the 
cme.xml file available to the Setup Wizard. This can be used in stead of the 
download as described in the next section. 

3. All IP Phones that are to be controlled by the CallController Server need to have the 
ephone username and password provisioned on the Cisco Unified CME router. 

4. The CallController Server supports both control and media termination mode of 
access to the Cisco Unified CME router. The control mode allows an existing IP 
Phone to be controlled from the user’s desktop. The Media Termination mode is used 
for the Mobility Server lines only. 
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This window allows you to specify the IP Phone parameters. If you have downloaded the 
IP Phone configuration from the Cisco Unified CME router, then the phones for the 
CallController can be selected from this list. 

Components of the Select Ephones Window 
 
Ephones (All Available Ephones):  
This table on the left displays the list of ephones downloaded from the Cisco Unified CME 
router. The first column is the Ephone ID and the second column lists the directory 
numbers on that Ephone. If you have not downloaded the configuration then this list will 
be empty. If you have a cme.xml file of a IP Phone configuration, then you can open this 
file by clicking on the browse button at the bottom of the Ephone list table. The Add and 
Add All buttons at the bottom of the Ephones table select the highlighted ephone or 
select all the ephones respectively. 
 
Selected Ephones (Ephones Controlled by UCC Server):  
This table lists the IP Phones that will be opened by the CallController Server. The table 
displays the username of the selected ephone, the directory numbers configured on that 
ephone, the IP address of the router, ID of the ephone. The fields at the bottom of the 
Selected Ephones table display the parameters of the ephone highlighted in the Selected 
Ephones table. These fields can also be used to manually enter or change the IP Phone 
information. The fields and buttons are described below: 
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Fields: 
CME IP Address: IP Address of the Cisco Unified CME router. 

MAC Address:  This is the MAC Address of the ephone. 

User Name:  This is the username configured for that ephone in the Cisco 
Unified CME router. 

Password:  This is the password configured  for the ephone. 

Ephone ID:  ID or number of the Ephone. 

DNs:  List of DNs configured on the ephone. This field is provided to 
distinguish between the ephones. 

Buttons: 
Connect as Softphone: Connect to the Cisco Unified CME as a softphone. These 

softphones are available for use only by the Automation Server 
applications.  

Add:   The current values of the ephone parameters are used to add a 
new entry in the Selected Ephone table. 

Update:  The current values of the ephone parameters are used to update 
the highlighted entry in the Selected Ephone table. 

Delete:  The highlighted entry n the Selected Ephone table is deleted. 

To Select an IP Phone for control by the UCC Server 
• Download the ephone list from the CME/UC500. 

• Click on an entry in the Ephones table. It will be highlighted. 

• Click on the Add button at the bottom of the Ephones table. The highlighted 
entry will be added to the Selected Ephones list. You can press the Shift or 
Control keys to select a range of or several ephones to add at one time. 

• To select all the ephones in the Ephones list, click on Select All button. 

To Select an IP Phone to connect as a softphone 
• Download the ephone list from the CME/UC500. 

• Click on an entry in the Ephones table. It will be highlighted. 

• Click and check the ‘Connect as Softphone’ option. 

• Click on the Add button at the bottom of the Ephones table. The highlighted 
entry will be added to the Selected Ephones list. You can press the Shift or 
Control keys to select a range of or several ephones to add at one time. 

• To select all the ephones in the Ephones list, click on Select All button. 

• If the selected entry in the Selected Ephones list does not show  ‘Connect as 
Softphone’ checked beside the MAC Address field, then click on that check 
box and then Update. 

NOTE: The ‘Connect as Softphone’ option is required by the UCC Mobility Service. 
Ephones configured in this manner are not available to the UCC users. 
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To Manually Add IP Phones: 
• Enter the User Name, Password, MAC-Address, CME IP Address in the 

fields. 

• Click on the Add button at the bottom of the Ephones table. A new entry will 
be added to the Selected Ephones list. 

To Delete an IP Phones: 
• Click on the Ephone that you want to remove in the Selected Ephones table. 

• Click on the Delete button at the bottom of the Ephones table. The 
highlighted entry in the Selected Ephones list will be deleted. 

 
Click on Next to continue to with the CallController Configuration. 

Verify Connection to Ephone 
This window allows you to verify that the CallController can connect to the IP Phone that 
you have selected or configured. The verification step is optional and provides a visual 
confirmation that a) the ephone exists and can be connected for control purposes b) the 
parameters configured for the ephone are connect.  
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Components of the Select Ephones Window 
Selected Ephones:  
This table lists the IP Phones that will be opened by the CallController Server. The table 
displays the ID of the ephone and the directory numbers configured on that ephone. 
When you click on an ephone in this list the key parameters are displayed in the field to 
the right. The fields and buttons are described below: 
 
Fields: 

User Name:  This is the username configured for that ephone in the Cisco 
Unified CME router. 

Password:  This is the password configured  for the ephone. 

MAC Address:  This is the MAC Address of the ephone. 

CME IP Address: IP Address of the Cisco Unified CME router. 
Buttons: 

Start:  Starts the connection process by registering to this ephone. 

Stop:  Terminates the registration process. 

Troubleshoot:  Opens the troubleshooting help file. 

To Verify the connection to an IP Phone: 
 Click on an entry in the Selected Ephones table. It will be highlighted and the 

connection parameters will be displayed on the fields to the right. 

 Click on the Start button. 

 The Wizard will attempt to register to the Cisco Unified CME router with the 
specified parameters and display the results. 

 If the connection was successful, then the line number and display names for 
each extension on the ephone will be listed. 

 You can click on each ephone and verify connection to the device. 
 
Click on Next to continue. 
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For each selected ephone, this window displays the extensions defined on the buttons 
with their number and DN-type. The DN-types can be dual-line, single-line, speed 
number or a feature button. By default all DN-Types are set to Dual-Line. You can click 
on the button to change the button type. 
 

 
 
NOTES: 
This version of the Unified CallConnector Server does not support dual line DN. If you 
have two calls presented concurrently at the one button, the last update is displayed in 
the client user interfaces. 
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Connecting to Multiple Communications Manager Systems 
The Unified CallConnector Server can be connected to multiple Cisco Unified CME 
routers or Unified Communication 500 systems. Please verify the system configuration 
with your Channel Partner. 
 

To Add Ephones from Additional CME Systems 
 

 Return to the Download Configuration Data from CME window. 

 Enter the connection information for the CME that you want to connect to. 

 Enter the Telnet user name and password. 

 Click on start to down load the ephone information from the new router. 

 Run through the steps as described above to add in additional ephones that are 
to be controller by the Unified Connector Server 

 
This completes the configuration for the CallController Server for one Cisco Unified CME 
router. 

 
Click on Next to continue with the user administration. 
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Configuring the Automation/Mobility Server 
The Automation Server executes user and administrator set rules or automatic functions. 
It uses the UCC Server applications to perform actions based on custom rules setup by 
the users. To setup the Automation, you need to configure the following information: 

 Specify the SIP communication parameters for Automation Server. 

 Setup the configuration parameters for the automaton or ‘services’ that are to be 
performed by the Automation Server. The initial service is the Mobility Single 
Number Reach function. 

 Enter the serial number for the Automation/Mobility Service. 

 Verify that the selected phones can be accessed and controlled by the 
Automation Server. 

 

SIP Communication Parameters 
 

 SIP Server Address: This is the IP address or network address of the computer 
with the System SIP Server. 

 Port: The Automation Server uses multiple ports. The value is the starting port 
address. The next four consecutive ports are also used by the Automation 
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Server.  This is the port used by the Presence Server to receive messages. The 
default value is 5072 through 5077. If this port range is not available, then 
change this to a port available on the computer. 

 Username: This is the well-known name of the Automation Server. This cannot 
be changed.  

 Password: This password is used to authenticate the registration of the 
Automation Server with the other system components. Enter the password. This 
can be any text or number string up to twelve characters in length. 

 If asked by Cisco Technical Support, enable the debug trace logging and set the 
Trace level to the requested level. This is checked at server startup only. By 
default the trace files are saved in the Trace Log folder under the Unified 
CallConnector Server. 

Click on Next to continue. 

Mobility Service Options 
The Mobility Service Options setup the configurable parameters for the Single Number 
Reach feature. This window also allows you to change the password for the system 
account ‘automationuser’ and enter the serial number for the Mobility Service.  
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Entering Mobility Service Serial Number 
The Unified CallConnector Mobility Service serial number is entered and updated from 
the Automation Mobility Service window. By default the starting serial number is set to 
‘trail’. This can be converted to a licensed version by entering a valid Server Serial 
Number.  

To Convert from Trial to Licensed Version: 
 

• Open the Server Setup Wizard to the Version Information page. 

• Delete the TRIAL_UCCS-xxxxxx trial serial number, enter the server serial 
number and click on update. 

• You will need to exit and restart the Setup Wizard to activate the serial 
number with the Unified CallConnector License Server. 

Mobility Service Parameters 

Fields: 
Use Hardware Conferencing: The Cisco Unified CME supports two basic 

methods of conferencing – hardware using DSPs and software 
conference. The conferencing method can be determined from 
the Telephony-Service section of the router configuration. The 

UCC Mobility Service supports both  these conferencing methods 
but need to know the conference setting of the router. ‘Use 

Hardware Conferencing’  should be checked if the Cisco Unified 
CME is configured for hardware conferencing otherwise this 

option should be unchecked.  

Notes: 1. If hardware conferencing is being used, then Ad-Hoc 
conferencing should be configured for the Mobility Service. 

2. The Mobility Service will not work correctly if the 
conferencing setting does not match the router 
configuration. 

Receive connect on Remote Answer: When an outgoing call is made to a PSTN 
number from an IP Phone, the call can get connected either if the 
CME immediately connects (analog gateways) or when the PSTN 
phone answers ( as in the case of digital PSTN gateways such as 

a T-1 or BRI lines). Check this option ‘Receive connect on 
Remote Answer’ if the call is connected when the PSTN phone 

answers. This option determines the start time and duration of the 
“request password prompt”. 

Allow Mid-Call Features: Once the caller and the user have been connected as a 
part of the Single Number Reach feature, the Mobility Service 

provides an option to stay connected to the call and allow the user 
to access Cisco Unified CME features such as transfer or 

conference. The ‘Allow Mid-Call Feature’ enables the 
administrator to make this feature available on their system.  
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Notes: 1.The Phase I Mobility Service does not support Mid-Call 
features. 

2. Mid Call features are only available with the hardware 
conferencing option.  

3. Mid-Call features occupy the mobility ephones and the 
conferencing function for the entire duration of the call. The 
resources available on the router need to be available to 
support this function. 

 

Same Router with DN: This option indicates to the Mobility Service that the 
ephone for the mobility service should belong to the router that 
has the specified DN. This option should be checked by default. 

Maximum Number of calls to locate user: This is the number of simultaneous 
calls allowed per single number reach session to dial out  to the 

user. The Mobility Service allows the administrator to set the 
maximum number of outgoing calls that can be make for each 
single number reach operation. This can be set from one to a 

maximum of four. 

Notes:  

1. The Phase I Mobility Service supports one outgoing call to 
locate the user. 

2. Each outgoing call requires a mobility ephone to place the 
call. So if you want to set the maximum number of outgoing 
calls to locate a user to two then that users single number 
reach operation could use up to three ephones. The 
resources available on the router need to be available to 
support this function. 

Duration of user answer timeout: This parameter specifies the maximum time the 
Mobility Service should wait trying to locate the user. On timeout 

the caller is sent to the user’ voice mail box. 

Transfer to Voice Mail: The UCC Mobility Service supports three methods for 
transferring a call to the Cisco Unified Unity voice mail system.  

The call is transferred to the user’s greeting. These three methods 
are – Direct Transfer to Voice Mail box using a Unity Auto-

attendant script, Transfer to the alternate ‘E164 mailbox number’  
and use the ‘Transfer to Voice Mail soft key.  

Using Transfer Script: This is a Cisco Unity Express (CUE) script that 
prompts for a voice mail box number. Once a valid 

mailbox number is entered, CUE plays the user’s greeting 
and the voice message is saved in the user’s mailbox. 

E164 Transfer: The Cisco Unity Express supports the provisioning of a 
Primary E 164 number (E164 number) for each CUE 
voice mailbox. Calls placed to this number are send 
directly to the user’s greeting and allows a call to be 

transferred directly to that mailbox. This requires setting 
up a dial-peer with a call forward-all to the main CUE 

number. 
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Direct Transfer Soft key: Not yet generally available. This feature is a soft 
key that allows a call to be transferred to CUE and 

receive a mailbox entry prompt. 

Automation User Account: The Mobility Services use this system user account to  
log in to the UCC Server.  The Automation User name is fixed. 

You can only change the password. 

Automation/Mobility Server Serial Number: The Mobility Service is a licensed 
service and required a serial number. This number is entered in 
this field and is applied when the Update button is pressed. The 

next time the Setup Wizard is run, it will present an activation 
window to register the serial number with the License Server. 

Holiday Schedule 
The Automation/Mobility supports setting up rules conditions that apply for work days or 
holidays.  The Holiday Schedule window allows you to setup the dates for the days that 
are holidays. 

 
The New, Add, Update and Delete buttons allow you to change and insert the holiday 
description and dates. To select the date click on the calendar icon. 
 
Note: The Holiday Schedule is not used for the Phase I Mobility Service. 
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Setting up Ephone Pools 
The Unified CallConnector Automation Server can host a number of automation 
applications. The automation applications can have ephone pools assigned. Each pool is 
configured from the wizard with four attributes – pool name, associated application, 
whether it has dedicated (ephones with shared DNs) and a list of ephones.  
 

 

To Create a New Ephone Pool: 
• Open the Server Setup Wizard to the Automation Ephone Pools page. 

• Click on Add button. The Add Application Pool window will open as shown 
above. 

• Enter the Pool name, application name and select ‘Yes’  if it has ephones 
with shared DNs. 

• Click on OK to apply the changes otherwise Cancel. Setup ephone pools. 
 
Once the Ephone Pool has been created, the ephones that have been configured in the 
CallController Server as ‘Connect as Softphone’ will be displayed in the available 
ephones list can be added into the newly created pool.  
 
From the available ephones list add the ephones for this pool. Only the ‘softphone’ 
ephones are displayed in this list. If you are connecting the UCC Mobility Service to 
multiple routers, then you will need to configure ephones from each of those routers. 

To Delete or Edit Ephone Pools: 
• Click on the Delete button to remove a Ephone Pool.  

• Click on the Edit button to bring up the Application Pools window to edit the 
Pool attributes.. 
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Cisco Unified CME Selection Parameters 
In multiple CME environments, the call pickup feature requires a local ephone to pick up 
the ringing call. For each CME you need to configure the ephones for the mobility 
service. The CME selection rules specify a range of DN that are associated with each 
CME. The Mobility Server uses this information to select a ephone that belongs to CME 
to initiate the Single Number Reach feature. 

 

To Specify CME Selection Rules: 
 
You must setup the CME Selection Rules even for single router configurations. 
 

• Click on the CME Selection Rules button  in the Automation Ephone Pools 
window. It will display the Update CME Selection Rules window. 

• This window lets you specify the extension number ranges available with 
each router. 

• Enter the starting and ending extension numbers form that CME router and 
click on Add. 

• If you are changing existing parameters, then click on Update. 
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• Check Hardware Conference if the router is configured for DSP-based 
hardware conferencing. 

 

Transfer to Voice Mail: The UCC Mobility Service supports three methods for 
transferring a call to the Cisco Unified Unity voice mail system.  

The call is transferred to the user’s greeting. These three methods 
are – Direct Transfer to Voice Mail box using a Unity Auto-

attendant script, Transfer to the alternate ‘E164 mailbox number’  
and use the ‘Transfer to Voice Mail soft key.  

Using Transfer Script: This is a Cisco Unity Express (CUE) script that 
prompts for a voice mail box number. Once a valid 

mailbox number is entered, CUE plays the user’s greeting 
and the voice message is saved in the user’s mailbox. 

E164 Transfer: The Cisco Unity Express supports the provisioning of a 
Primary E 164 number (E164 number) for each CUE 
voice mailbox. Calls placed to this number are send 
directly to the user’s greeting and allows a call to be 

transferred directly to that mailbox. This requires setting 
up a dial-peer with a call forward-all to the main CUE 

number. 

Direct Transfer Soft key: Not yet generally available. This feature is a soft 
key that allows a call to be transferred to CUE and 

receive a mailbox entry prompt. 

 
 
 



Chapter 4 Configuring Servers 
 

4-36  Cisco Unified CallConnector Server 

Creating Group List: 
You can define a set of groups or department. A list of common group names are pre-
installed. These can be used, modified or deleted based on your organization. Each 
Unified CallConnector user has to be placed within a group or the system will place them 
in the Default group.  

 

Components of the Group Window 
 
Groups:  
This table lists the groups that have been defined for use with the Unified CallConnector. 
The table displays the ID of the Group and the Group Name. The ID is an internally used 
parameter and cannot be changed.  
 
Restricted Groups:  
This table lists the groups whose users cannot view the presence status of the members 
of the Group currently selected in the Groups table.  
 
Available Groups:  
This table lists the groups whose users can view the presence status of the members of 
the Group currently selected in the Groups table. 
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Group Buttons (at the bottom of the Groups table): 
Refresh:    Re-reads the group information from the database and displays it 

in the table.  
 
Browse:  Allows you to open and import the group-list from the 

GroupsTable.xml file. This file is saved in the Data folder under 
Unified CallConnector Server.  

 
Fields (fields and buttons to the right of  the Groups table): 

Group ID:  This is the ID number of the group and is assigned automatically 
by the system. 

Group Name:  This is the name of the group. 

Buttons: 

New:  Clears the Group name to allow you to add an new entry. You 
will need to click on Add to apply. 

Add:  Creates a new entry with the group name specified in the field 
above. 

Update:  Changes the name of the currently selected group with the name 
in the group name field above. 

Delete:  Removes the currently selected group name. If any user was 
placed in  this group then that association is changed to the 
default group. 

Restricted Groups Buttons: 

Delete:  Removes the currently selected group in the Restricted Group to 
the Available Group. 

Available Groups Buttons: 

Add:  Moves the currently selected group in the Available Group to the 
Restricted Group. 

To Update an existing Group Name: 
 Click on an entry in the Groups table. It will be highlighted. 

 Modify the name in the Group Name field 

 Click on the Update button. The highlighted group name will be replaced with the 
new name entered in the Group Name field. 

To Add a New Group: 
 Enter the group name in the Group Name field. 

 Click on the Add button. A new entry will be added to the Groups list. 

To Delete a Group: 
 Click on the Group name that you want to remove in the Groups table. This 

group name will be displayed in the fields to the right. 

 Click on the Delete button. The highlighted entry in the Groups list will be 
deleted. 
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To Restrict Members of a Group from Viewing Status: 
 In the Groups table, click on the Group Name to which you want to apply the 

access restrictions.  

 The Available Group table will display the Groups whose members can view the 
status of the users in the Group highlighted in the Groups table. 

 The Restricted Group table will display the Groups whose members cannot view 
the status of the users in the Group highlighted in the Groups table. 

 Click on the Group name that you want to restrict in the Available Groups table. 
Then click on Add. 

 This Group will be moved to the Restricted Groups list. 

To Allow Members of a Group Access to Viewing Status: 
 In the Groups table, click on the Group Name to which you want to apply the 

access restrictions.  

 The Available Group table will display the Groups whose members can view the 
status of the users in the Group highlighted in the Groups table. 

 The Restricted Group table will display the Groups whose members cannot view 
the status of the users in the Group highlighted in the Groups table. 

 Click on the Group name that you want to allow in the Restricted Groups table. 
Then click on Delete. 

 This Group will be moved to the Available Groups list. 
 
 
Click on Next to continue to with the User Configuration. 

 

 

 



Configuring Servers     

Administrator Guide   4-39 

Managing Users: 
The Unified CallConnector users need an account to be setup with login name and 
password to connect to the UCC Serve. The Server Wizard Managing Users window 
allows you to add, delete and update the Unified CallConnector user information. It allows 
you to perform the following management functions: 
 

 Add a Unified CallConnector user. Assign the user login name and password. 

 Delete a user. This removes the user from the system and will reject login 
attempts with on that account. 

 Change the contact information of the UCC user. Note - users are also able to 
update their contact information from the Options window. 

 Change the user login name and password. 

 Assign the user type and the user’s group. 

 Import the user list from a xml file. 
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Components of the User Administration Window 
User Table:  
This table lists the user accounts that have been defined for the Unified CallConnector. 
Only these users will be able to login to the Unified CallConnector Server. The table 
displays the User ID of the user and the User Display Name. The ID is an internally used 
parameter and cannot be changed.  
 
User Table Buttons (at the bottom of the User Table): 
 

Refresh: Re-reads the user information from the database and displays it 
in the table.  

Browse: Allows you to open and import the user-list from the Users 
Info.xml file. An example file is saved in the Data folder under 
Unified CallConnector Server.  

 
The fields and buttons to the right of  the Users Table are described below: 
 
Fields (to the right of  the Users Table): 

User ID:  This is the ID number of the user and is assigned automatically 
by the system. 

First Name:  This is the first name of the user. 

Last Name:  This is the last or family name of the user. 

Login Name:  This name is used by the user to login to the Unified 
CallConnector Server. 

Password:  The password to be used to login. 

Company:  User’s organization or company name. 

User Type:  Three types of user accounts are supported. 

User:   A standard Unified CallConnector user 

Manager:   This user, in addition to the standard user functions, is able to 
change the status of the other users in the group for which they 
are the manager. 

Administrator:  An administrator is able to change system wide configuration 
data. 

Serial Number: This is the client serial number. It is provided to help with the 
license number administration. Each user’s serial number can 
also be sent out to the user with the email notification feature of 
the Server Wizard. 

Business:  The work or business telephone number. This would be the 
primary number provisioned on the user’s IP Phone. 

Business2:  A second work or business telephone number. (In configurations 
where the dual-line DN are set to an extension number and the 
secondary to a DID number, this fields can be used to enter the 
DID number) 

Home:  The home telephone number. 

Mobile:  The mobile or cellular telephone number. 

Email:  User’s email address. 



Configuring Servers     

Administrator Guide   4-41 

SMS:  User’s SMS address. This is typically the mobile-
number@service-provider.com 

IM:  Instant Message address. This is the login name of the user. 

Group:  This is the name of the group the user belongs to. 

Voice Mailbox:  The user’s voice mailbox number 

Tel Password:  This is the password to be entered to accept Single Number 
Reach calls. 

 
Buttons (to the right of  the Users Table): 

New:  Clears the user information fields to allow data for a new user to 
be entered. You need to click on Add to apply the change. 

Add:  Creates a new user account with the user parameters specified 
in the fields above. 

Update:  Changes any changes to the currently selected user’s 
information. 

Delete:  Removes the currently selected user account. 

To Update an existing User Account : 
 Click on an entry in the User Table. It will be highlighted. 

 Modify the user parameters in the fields to the right. 

 Click on the Update button. The highlighted user account information will be 
replaced with the information entered or changed. 

To Add a New User: 
 Click on the New button to clear the information  in the User Parameter fields. 

 Enter the user information in the User Parameter fields. 

 Click on the Add button. A new entry will be added to the User Table. 

To Delete a User Account: 
 Click on the User name that you want to remove in the User Table. This user 

information will be displayed in the fields to the right. 

 Click on the Delete button. The highlighted entry in the  User Table will be 
deleted. 

 
Click on Next to continue to with the User Configuration. 
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Adding Phones to Users 
The User’s Phone Window displays three tables – User List, Available Phone List and the 
User’s Phone. 

Users -- This table displays all the users configured on the Unified 
CallConnector Server. 

User’s Phones  - For the user highlighted in the Users table, this table displays 
the phone(s) that are associated with and can be controlled by 
the user. This is currently restricted to one phone. 

Phones  --  This table displays all the phones that have been configured for 
the Unified CallConnector. These phones can be controlled from 
the Unified CallConnector clients. 
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To Associate a Phone with User: 
 Select the user by clicking on the user name entry in the User table. 

 Click on the IP Phone that you want to have the user control in the Phones table. 
This entry will be highlighted. 

 Click on the Add button to associate this phone with the selected user. The 
selected phone will be displayed in the  User’s Phone list. 

 ‘Update User Contact’ checkbox automatically updates the Business phone 
number with the primary DN on the selected ephone. 

Notes:  1. The current release of the Unified CallConnector clients only support a single 
IP Phone per user. 
 2. The same IP Phone can be associated with more than one user. However in 
this situation, all such users have ability to control the call. 

To Delete a User’s Phone: 
 Select the user by clicking on the user name entry in the User table. 

 Click on the users IP Phone that you want to delete in the User’s Phones table. 
This entry will be highlighted. 

 Click on the Delete button to remove this phone from the user. The selected 
phone entry will be deleted in the User’s Phone list. 

 
Click on Next to continue to Send Email Notifications or Report Problems. 
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Sending Email Notifications 
The Server Wizard provides a facility to send email messages to the Unified 
CallConnector users. This email notification facility can be used to send messages to 
selected users or to all the users. 
 
The Email Notification feature allows you to automatically append the following 
information with the email: 
 

Append Login Information: When this option is selected, the user’s login name, 
password and serial number are included in the body of the 
email massage. Each user is send only their login information. 

Attach Default Configuration File. The Unified CallConnector client configuration 
options are saved locally in an xml file. The default configuration 
file allows the administrator to pre-define or customize this 
configuration file for the users. When the option is selected, then 
the configuration file is sent as an attachment. 

Quick Reference. This option allow you to attach notes or other documents in the 
notification email to the user. 
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Components of the Email Notification Window 
User List:  
This table displays a lists of the Unified CallConnector users and their email addresses. 
The check box beside each user allows you to select that user to receive the email 
message. 
 
Subject:  Email subject text for the notification message. 
 
Message Body: Text of the email to be sent to the users. 
 

Buttons: 

Clear All:  Clears all the selections in the User List table. 

Select All:  Selects all the users in the User List table to receive the email 
message 

Append Login Information: Automatically adds the user’s login name, password 
and serial number in the email message. 

Default Configuration File: Attaches the administrator customized configuration 
file to the email message.  

Advanced Configuration: Opens the configuration file to allow site specific values 
to be entered. 

Quick Reference: Allows you to attach a selected file such as a Quick Reference 
document to be sent to the user. 

Email Config:  Opens a window for setting the email account information. 

Send Email:  Sends email to the selected users. 

To Send the Users a Notification Email Message: 
 Select the users that you want to send the email message. Click on each user or 

click on Select All to select all the users. 

 Enter the subject and email text. 

 Click on the optional information that you want to attach with the email message. 

 Click on Send Email to send the message. 
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To Setup the Email Account: 
 Click on the Email Config button in the Send Email Notification window. 

 Enter the SMTP email server information and the account you want to use to 
send the email messages. 

 Click  on OK to save the information. 
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Advanced Configuration Parameters 
The Advanced Configuration Parameters provides a mechanism for the administrator to 
customize and distribute standard user configuration parameters during the installation 
process.  
 
The user login/account information, software serial number and UCC client configuration 
data can be sent to the user via email. This can simplify the UCC client installation as 
most of the installation parameters can be read from this file by the install program. 
 
When the client install is run, it looks for this configuration xml file in the user’s desktop.  
 
The Configuration parameters that can be customized are described below: 
 

 

To Customize the Configuration Values: 
 Click on the Advanced Configuration button and change the parameter values. 

 Click on OK to save the changes. These settings will be sent in the email to the 
user by selecting the Default Configuration file option. 
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Reporting Problems 
To report problems to the Unified CallConnector, select all or the desired trace files. Enter 
the description of the problem and the steps for reproducing them and click on Send 
Problem Report to send the email with the attachments. 
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 Cisco Unified CME Router 
Configuration 

 
 
 
 
 

The Cisco Unified CallConnector Servers connect to the Cisco Unified Communications Manager 
Express (Cisco Unified CME) routers to receive call status information, to control the call on the 
user’ IP Phones as well as terminating calls. Both ends of these connections, the Cisco Unified 
CME router and the Cisco Unified CallConnector Server, need to be configured to allow these 
connections to operate correctly.  
 
This chapter describes the configuration required on the Cisco Unified CME router to allow the 
Unified CallConnector Servers to access and control the IP Phones. These include: 

 
Connections Overview  - Describes the interfaces or inter-working between the 

Cisco Unified CME router and the Unified CallConnector 
Servers. 

Ephones Parameters - Describes the parameters that have to be configured on 
the ephones to allow the CallController Server to open 
communication sessions.  

Radius Parameters - Describes how to configure the Radius parameters on 
the Cisco Unified CME router to allow the Presence 
Server to receive accounting packets.  

Verifying Connections Describes the steps to verify that the connections have 
been successfully made between the Cisco Unified CME 
router and the Unified CallConnector Servers.\ 

Additional Configuration  
for Automation Server Describes the steps to verify that the connections have 

been successfully made between the Cisco Unified CME 
router and the Unified CallConnector Servers 

 

 
CHAPTER 
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Cisco Unified CME Connections 
The Unified CallConnector Server applications make the following connections to the 
Cisco Unified CME: 
 

TAPI connection:  The CallController Server application connects to the Cisco Unified CME 
ephones over the TAPI port. 

Softphone (Ephone): The CallController Server application emulate the Cisco Unified CME 
ephones. 

For Radius Messages: For receiving Radius accounting packets for the call events on  the Cisco 
Unified CME router. 

Telnet Connection:  This is an optional connection used during configuration to download the 
ephone parameters to simply the configuration process. 

The table below shows these connections and the information/configuration required on 
each of the systems. 

 

 UCC Server Cisco Unified CME Router 

Telnet  Cisco Unified CME IP 
Address 

 Telnet User name 

 Telnet Password 

 Setup a Telnet account for 
downloading the configuration 
information. Does not require exec 
level access. 

Call Control from 
UCC Server 

 Cisco Unified CME IP 
Address 

 Ephone User Name 

 Ephone Password 

 Configure user name and password on 
all the ephones that are controlled from 
the UCC Server 

Emulating Ephone  Cisco Unified CME IP 
Address 

 Ephone MAC Address 

 Ephone User Name and 
Password 

 Configure ephones with virtual MAC 
Address with three single channel 
DNs. These ephones are registered 
and connected as softphones from the 
CallController Server. 

Radius Accounting  Configure Password  

 Configure Port  

 Configure the Radius Accounting 
Parameters on Cisco Unified CME 
router 

 Verify that the password and port are 
the same as the UCC Server 
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 Ephone Parameters for Call Control 
The Cisco Unified CallConnector Server connects to the Cisco Unified CME IP Phones to 
allow the user to control their phones from the Unified CallConnector clients such as the 
toolbars. This connection is made over the TAPI port of the Cisco Unified CME router. 
 
The Unified CallConnector server application – CallController Server registers and 
establishes a connection over the Cisco Unified CME TAPI port to the ephones that have 
been configured for use by the Unified CallConnector. To establish this connection each 
ephone much have the username and password field provisioned on the Cisco Unified 
CME router. 
 

Example of Ephone Configuration 
 
ephone-2 Mac:0013.C307.E9C0 TCP socket:[11] activeLine:0 
REGISTERED in SCCP ver 
6 and Server in ver 5 
mediaActive:0 offhook:0 ringing:0 reset:0 reset_sent:0 paging 0 
debug:0 caps:7 
IP:192.168.1.5 50179 Telecaster 7960  keepalive 132940 max_line 6 
button 1: dn 4  number 5014 CH1   IDLE 
button 2: dn 5  number 3 CH1   IDLE 
button 3: dn 6  number 5015 CH1   IDLE 
button 4: dn 43 number 5043 CH1   IDLE         CH2   IDLE 
Username: john Password: cisco 
Tapi client information 
 
Username:john  status: REGISTERED Socket : [46] 
 Tapi Client IP address:  192.168.1.17  Port: 3426 
 
 
Notes:  1. Username and password are required to allow a TAPI connection to the IP 
Phone. 
2. When a TAPI session is established, the TAPI client information can be viewed using 
the  ‘Show Ephone TAPI ’ command. The TAPI client information displays the status 
‘REGISTERED’ and the Client IP address. 
 

Pre-Requisites for Connecting to Ephones: 
 
 Ephone must be configured with user name and password 

 There must be a phone device registered to the ephone 

 There must be network access for the TCP connections between the Cisco Unified 
CME router and the UCC Server 

 There must be no existing TAPI connections to the ephone. The Cisco Unified CME 
router supports only one TAPI connection per ephone. 
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Connection Recovery and Timeouts 
The Unified CallConnector Server tries to establish connections to all the ephones 
configured for the UCC Server. Normally these ephones will be a sub-set of all the 
ephones in the Cisco Unified CME. In the event these connections fail either at startup or 
during operation, the Unified CallConnector CallController Sever will try to re-establish 
these connections. The recovery of these ephone connections follow these rules: 
 

 The UCC Server will try to establish connection to the ephone multiple times up 
to the Max-Retry count – a configurable parameter. 

 The interval between the retries is a configurable period and is set to 6 minutes. 

 If the connection cannot be re-established within the maximum retries, then UCC 
Server will wait for a configurable time period and then return to trying to re-
establish the ephone connection. 

 

Ephone Parameters for Softphone Emulation 
The Unified CallConnector server application – CallController Server registers and 
establishes  connection to the Cisco Unified CME as softphone to emulate ephones that 
have been configured for use by the Unified CallConnector. To establish this connection 
each ephone much have the MAC Address configured as a virtual address, type must be 
7960 and should be configured with three DNs (single channel)  for use by the mobility 
service.. 
 

Example of (Mobility) Ephone Configuration 
 
ephone-2 Mac:AAAA.AAAA.1000 TCP socket:[11] activeLine:0 
REGISTERED in SCCP ver 
6 and Server in ver 5 
mediaActive:0 offhook:0 ringing:0 reset:0 reset_sent:0 paging 0 
debug:0 caps:7 
IP:192.168.1.5 50179 Telecaster 7960  keepalive 132940 max_line 6 
button 1: dn 4  number 5013  CH1   IDLE 
button 2: dn 5  number 5014  CH1   IDLE 
button 3: dn 6  number 5015  CH1   IDLE 
Username: john Password: cisco 
Keep-conference 
 
 

Notes:  1.Mobility ephones should be configured with a virtual MAC address for example 
AAAA.AAAA.1000. 
2.The Mobility Service requires three single-line DN to be configured for each ephone. 
3. Keep-conference option should be enabled to allow the conferenced parties to remain 
connected when this ephone drops out of the call. 
 

Configuring Mobility Ephones: 
 
 Ephone must be configured with virtual MAC address 

 This MAC address and the router IP address must be configured for the UCC 
CallController Server. 
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 The option “Connect as Softphone” must be enabled for these mobility ephones. 

Setting Up the Radius Accounting  
The Cisco Unified CME router and its underlying Cisco IOS platform can be setup to 
generate accounting packets for the calls being generated within the system. These 
accounting messages can provide information on the start-time and end-time of the call 
as well as the caller/called numbers. The accounting messages are sent to RADIUS 
servers using a standard protocol. 
 
The Unified CallConnector Presence Server provides a RADIUS server interface to 
connect with and receive the Radius accounting messages from the Cisco Unified CME 
router. 

Radius Parameters 
The Cisco Unified CME router has to be configured to enable the voice Radius 
accounting packets to be sent to the Unified CallConnector. The Unified CallConnector 
Server acts as the Radius Server and the Cisco Unified CME router is the Radius client 
that generates and transmits the radius packets. 
 
Cisco RADIUS VSA Voice Implementation Guide provides more details on the Radius 
setup options. The configuration of the Radius parameters on the router for providing 
telephone status information to the Presence Server include the following steps. 
 

 Enabling AAA accounting  

 Enabling Connection-based Accounting 

 Setting up the Radius Server IP address and port 

 Entering the Authentication Key or password 

 Enabling the Cisco Accounting Attributes – Vendor Specific Attributes 
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To Setup Radius Parameters on Cisco Unified CME  Router 
The table below displays the commands for setting up the Radius parameters on the  
Cisco Unified CME router using Cisco IOS commands. 
 

Command Description 

enable 

Router> enable 

Enters Exec mode 

configure terminal 

Router # configure term 

Enters global configuration mode 

aaa new-model 

Router (config)#  aaa new-model 

Enables AAA 

aaa accounting update 

Router (config)# aaa accounting update 
newinfo 

Enables sending update packets for new 
information 

aaa accounting connection h323 start-stop radius 

Router (config)# aaa accounting connection 
h323 start-stop broadcast group uccserver 

Enables connection based accounting and 
send stop and start packets 

aaa group server radius uccserver 

aaa grouop server radius uccserver  

server 1.1.1.1 auth 1645 account 1646 

Defines the IP address and ports for the server 
group 

radius-server host 

Router (config)# radius-server host 
1.1.1.1 auth-port 0 acct-port 1646 

Specifies the Radius Server IP-Address  and 
accounting port.  

The IP Address and Port should match the 
setting on the Presence Server Radius 
configuration. 

radius-server key 

Router (config)# radius-server key 
password 

Sets the password for authenticating the 
Radius server. 

Note: This same password should  be entered 
as the  Radius Authentication Key (password)  
in the Server Wizard. 

radius-server vsa 

Router (config)# radius-server vsa send 
accounting 

Sends vendor specific attributes. 

gw-accounting 

gw-accounting aaa 

Enables accounting packets for the gateway 
interfaces 
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Below is an example of the router configuration file showing the Radius parameter 
settings. 
 

aaa new-model 

aaa group server radius uccserver 

 server 192.168.1.116 auth-port 1645 acct-port 1646 

aaa accounting update newinfo 

aaa accounting connection h323 start-stop broadcast group uccserver 

aaa session-id common 

gw-accounting syslog 

gw-accounting aaa 

radius-server host 192.168.1.116 auth-port 1645 acct-port 1646 

radius-server key uccserver 

radius-server vsa send accounting 

radius-server vsa send authentication 

Verifying Connections to the Cisco Unified CME 
Router 

The following steps can be taken to verify that the connections between the Cisco Unified 
CME router and the Unified CallConnector Servers have been properly established or are 
in place. 
 

To Verify TAPI Connection to Ephone 

From the Cisco Unified CME router: 
1. From the command line interface, use the ‘show ephone tapi’ command to list the 

ephones with TAPI connections.  
 
cc2800#show ephone tapi 
 
ephone-2 Mac:0013.C307.E9C0 TCP socket:[11] activeLine:0 
REGISTERED in SCCP ver 
6 and Server in ver 5 
mediaActive:0 offhook:0 ringing:0 reset:0 reset_sent:0 paging 0 
debug:0 caps:7 
IP:192.168.1.5 50179 Telecaster 7960  keepalive 132940 max_line 6 
button 1: dn 4  number 5014 CH1   IDLE 
button 2: dn 5  number 3 CH1   IDLE 
button 3: dn 6  number 5015 CH1   IDLE 
button 4: dn 43 number 5043 CH1   IDLE         CH2   IDLE 
Username: john Password: cisco 
Tapi client information 
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Username:john  status: REGISTERED Socket : [46] 
 Tapi Client IP address:  192.168.1.17  Port: 3426 
 

2. From the command line interface, use the ‘debug ephone register’ command to monitor 
the registration of the TAPI connections to the ephones.  

From the Unified CallConnector Server 
1. Open the UCC Diagnostic Tool. See Chapter 8 for more details. 
2. Make a few calls from on the IP Phones. 
3. From the CallController Server tests, run the Display All Phone Statistics test. 
4. This will display the registered ephones and some basic call statistics. 

To Verify Radius Events 

On the Cisco Unified CME: 
1. From the command line interface, use the debug command to view the radius accounting 

messages being sent: 
 

The debug message below was generated on an off-hook and sent to Radius-Server at IP 
Address 192.168.1.17 
 
Note: Use of debug commands, especially verbose debug command, can place a heavy load 
on the router and can impact other functions on the router. 
 
cc2800#debug radius verbose 
cc2800#term mon 
cc2800# 
*May 13 13:27:00.648: RADIUS/ENCODE(0007DEA8):Orig. component type = VOICE 
*May 13 13:27:00.648: RADIUS/ENCODE: Skip encoding 0 length AAA attribute 
dnis 
*May 13 13:27:00.648: RADIUS(0007DEA8): Config NAS IP: 0.0.0.0 
*May 13 13:27:00.648: RADIUS/ENCODE(0007DEA8):Orig. component type = VOICE 
*May 13 13:27:00.648: RADIUS/ENCODE: Skip encoding 0 length AAA attribute 
dnis 
*May 13 13:27:00.648: RADIUS(0007DEA8): Config NAS IP: 0.0.0.0 
*May 13 13:27:00.648: RADIUS/ENCODE(0007DEA8):Orig. component type = VOICE 
*May 13 13:27:00.648: RADIUS/ENCODE: Skip encoding 0 length AAA attribute 
dnis 
*May 13 13:27:00.648: RADIUS(0007DEA8): Config NAS IP: 0.0.0.0 
*May 13 13:27:00.648: RADIUS/ENCODE(0007DEA8):Orig. component type = VOICE 
*May 13 13:27:00.648: RADIUS/ENCODE: Skip encoding 0 length AAA attribute 
dnis 
*May 13 13:27:00.648: RADIUS(0007DEA8): Config NAS IP: 0.0.0.0 
*May 13 13:27:00.652: RADIUS/ENCODE: Best Local IP-Address 192.168.1.121 for  

Radius-Server 192.168.1.17 
*May 13 13:27:00.652: RADIUS(0007DEA8): Send Accounting-Request to  

192.168.1.17:1646 id 1646/149, len 565 
 

From the Unified CallConnector Server 
1. Open the UCC Diagnostic Tool. See Chapter 8 for more details. 
2. Make a few calls from on the IP Phones. 
3. From the Presence Server tests, run the View Radius Call Info test. 
4. If the Presence Server has received the Radius messages from the CME, the last ten call 

information messages will be displayed. 
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Additional Configurations for Mobility Service 
 

Configuring CME ephones for the UCC Mobility Service 
A pool of ephones is used by the Mobility Server to pickup the incoming call and make 
the reach out calls. These ephones have to be configured on the CME and selected 
during the configuration of the UCC Server. 
 

 Configure three ephone-DNs for each ephone configured for the Mobility Service. 
Each ephone-DN should be a Single Line or Single Channel DN.  

 The ephones are used to pickup a ringing call and play the ‘wait for user’ prompt’. 
Other ephones are also used to make outgoing calls to locate the user.  The 
number of ephones equals the “Number of Simultaneous SNR attempts times the 
“Maximum Number of Concurrent Calls to locate a user”. Each ephone should be 
configured with three ephone-DNs, keep-conference option, user name and 
password. You should configure a Virtual MAC Address for each of the ephones. 
An example Virtual MAC Address would be AAAA.AAAA.1000. 

 Handling ‘Shared or Switching to IP Phone’: This feature allows a Mobile Reach 
out calls to be placed on a user’s shared appearance extension. This can enable 
the user to pickup their Single Number Reach call by placing it on hold on the 
mobile device and picking it up on the shared appearance button. To support this 
function the Mobility Service supports an option for a  dedicated pool of ephones, 
if the ringing extension is found in this pool and the ephone is available then that 
ephone is used start the single number reach service. (Phase II) 

 

 Examples : 

ephone-234 Mac:AAAA.BBBB.4512 TCP socket:[231] activeLine:0 
REGISTERED in SCCP ver 3 and Server in ver 3 

mediaActive:0 offhook:0 ringing:0 reset:0 reset_sent:0 paging 0 
debug:0 caps:3 

IP:192.168.1.17 2579 Telecaster 7960  Telstrat keepalive 191 
max_line 16 

button 1: dn 373 number 4373 CH1   IDLE 

button 2: dn 374 number 4374 CH1   IDLE 

button 3: dn 375 number 4375 CH1   IDLE 

Username: 38user234 Password: cisco 

 

ephone-235 Mac:AAAA.BBBB.4513 TCP socket:[232] activeLine:0 
REGISTERED in SCCP ver 3 and Server in ver 3 

mediaActive:0 offhook:0 ringing:0 reset:0 reset_sent:0 paging 0 
debug:0 caps:3 

IP:192.168.1.17 2580 Telecaster 7960  Telstrat keepalive 191 
max_line 16 

button 1: dn 376 number 4376 CH1   IDLE 
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button 2: dn 377 number 4377 CH1   IDLE 

button 3: dn 378 number 4378 CH1   IDLE 

Username: 38user235 Password: cisco 

Support for Multiple CME Routers 
 

The UCC Mobility Service has been designed to support multiple routers. Following are 
known constraints for the multiple router environments: 
 
• Mobility ephones must be defined on each router for use by the Mobility Service. 

• Direct transfer to Voice Mail must be configured for each router. UCC Mobility 
Service supports configuration of transfer to voice mail on a per router basis. 

• Extension number length must be the same for each router. The outside dial access 
code also must be the same for each router. The current assumption is that the 
routers are in the same telephone area code. 

• Hardware/Software Conference option can be set individually for each router. 

• The RADIUS service must be enabled on all the routers and the authentication 
password must be the same on all the routers. 

 
The Phase I UCC Mobility Service is being introduced as qualified on single routers but 
with an ability to support multiple routers. 

 

Configuring CME to allowing calls to be looped through the CME 
The Cisco Unified CME must be configured to allow incoming PSTN call to be looped 
back through the router to another PSTN call. This situation is encountered when an 
incoming call for a user is routed for example to their cell-phone. This call needs to be 
maintained until one of the parties hangs up. 

Configuring Direct Transfer to Voice Mail 
 
Three methods of transfer to voice mail are supported. A) Using Transfer-to-
Voicemail soft key, b) Using the E164 number and c) Using a CUE script. 
 
Example for Setting up CUE Script: 
CUE: 

ccn application directlytransfertovoicemail 
 description "directlytransfertovoicemail" 
 enabled 
 maxsessions 8 
 script "directxfer.aef" 
 parameter "numDigitsToCollect" "4" 
 end application 

ccn trigger sip phonenumber 6000 
 application "directlytransfertovoicemail" 
 enabled 
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 maxsessions 8 
 end trigger 

CME: 

! 
dial-peer voice <TAG>  voip 
 description TransferVM_CUE_SCRIPT 
 destination-pattern 6000 
 session protocol sipv2 
 session target ipv4:<CUE-ADDRESS> 
 dtmf-relay sip-notify 
 codec g711ulaw 
 no vad 
! 

 Method c) is preferred as it requires the least configuration on the CME. 
 
Note: Transfer patterns must be setup to allow PSTN calls to be transferred using the 
Direct Transfer to Voice Mail option. 

Configuring Hardware Conferencing on the CME 
 

Configure Hardware conferencing on the CME. Ad-Hoc conferencing is used by the UCC 
Mobility Service. This should be setup on the CME. Please see the Cisco Unified CME 
Administration Guide for setting up the CME Hardware Conferencing. 
 

Other Notes on Mobility Service Configuration 

Customizing Timeouts and Voice Prompts 
The UCC Mobility Service provides support for voice prompts in multiple languages and 
the option of custom prompts. The available languages can be selected from the 
Configuration Wizard. If the desired language is not available, the administrator can 
select the Custom Language option. For this option all the prompt files have to be 
manually copied over and recorded. Following constraints apply for customizing the voice 
prompts: 
 
1. The file names cannot be changed. 

2. The audio file format supported is PCM, 16 Kbps data rate, 8KHz sample rate, 16 bit 
sample size, mono channel. 

3. The timeouts values for the Single Number Reach states is defined in the 
SNRAutomationRouted.xml.  

This file can be found in the \Automata folder
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 Starting and Stopping 
Services 

 
 
 
 
 
 
 
This chapter describes how to start and stop the Unified CallConnector Server 
applications and verify that the services are running. 

 

This chapter describes the following in more detail: 

 

Using UCC Services Manager –Describes how to start and stop the Unified 
CallConnector Server applications using the 
Services Manager application. 

Using Windows Services - Describes how to start and stop the Unified 
CallConnector Server applications using the 
Windows Services program. 

Verifying Operation - Describes how to verify that all the server 
applications are running properly. 
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Starting/Stopping Server Applications Server 
These Unified CallConnector Server applications run as Windows services and do not 
have any user interfaces. When the applications are running their status can be viewed in 
the Windows Task Manager and Services application. 
 
The Unified CallConnector Server applications can be started in two ways: 
 

 From the CTI Services Manager Application 

 From the Windows Services 

Using the CTI Services Manager 
The CTI Services manager application is a tool to start and stop the collection of the 
server applications that comprise the Unified CallConnector server.  The CTI Services 
Manager also displays the current status of each of the CallConnector server 
applications. It polls the status of the services and displays the current running state. 
 
From the Start-Programs menu, select the Cisco Systems group and select the Cisco 
Unified CallConnector Server option, then click on CallConnector Service Manager. 
 
 

 
 
The CallConnector Services Manager application will run and display the status of the 
Unified CallConnector server applications. The CallConnector Services Manager window 
has a status field that indicates if all services are running or if some are stopped.  
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The window has three buttons: 
 
Show Details/Hide Details:  This button opens or closes a list of the Unified 
CallConnector Server applications and their current status – started or stopped. 
 
Start:  This button starts all the server applications. This button is only available when all 
the services are stopped. The services are started in their dependency order. 
 
Stop: This button stops the services. If some services are stopped, then all services have 
to be first stopped before they can be started from the CallConnector Services Manager. 
 
The window below shows the CallConnector Services Manager with all the services 
running. 
 

 

To Start the Server Applications 
 

 Start the Unified CallConnector Service Manager application from the Start-
Programs menu. 

 If some Server Applications are stopped, then click on Stop.  

 If some services do not stop, then open the Task Manager and from the 
Process window select the Unified CallConnector Server and click on End 
Process. 

 When all the Server Applications are stopped, click on the Start button. 

To Stop the Server Applications 
 

 Start the Unified CallConnector Service Manager application from the Start-
Programs menu. 

 Click on Stop button. 
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 If some services do not stop, then open the Task Manager and from the 
Process window select the Unified CallConnector Server and click on End 
Process. 

Using Windows Services Manager 
The Windows Services interface displays all the service applications that have been 
configured for that computer and describes their current status. This window also allows 
you to start and stop these services. In order for a server application to be displayed in 
this window, the application has to be configured to run as a service. 
 
The Services management application one of the Administrative tools available with the 
Windows operating system.  To open the Services application, from the Control Panel 
select Administrative Tools and click on Services. 
 

 
This will open the Windows Services management application. The Unified 
CallConnector Server applications all start with cc… as shown in the picture below. 
 
From this services window, you can perform some of the following functions: 
 

 Start/Stop a Service 

 Setup the service to start with Window Startup 

 Define the Recovery actions if the service fails. 
 
The Unified CallConnector installation program will setup the CallConnector Server 
Applications as manually started Windows services. It also sets the Recovery actions to 
automatically restart upon failure. 
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Server Application Dependencies 
The Unified CallConnector Server applications should be started in the following 
sequence: 

 

1. System SIP Server 

2. System Tracker 

3. Database Server 

4. CallController Server 

5. Presence Server 

6. Rules/Mobility Server 

 

To Start a Server Applications 
 

 Open the Windows Services application from Control Panel->Administrative 
Tools->Services. 

 Select the Service that you what to start by clicking on the service name.  

 Click on the Start button or right-click and select Start. 

 When the selected service is running, the status will change to Started. 

To Stop a  Server Applications 
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 Open the Windows Services application from Control Panel->Administrative 
Tools->Services. 

 Select the Service that you what to stop by clicking on the service name.  

 Click on the Stop button or right-click and select Stop. 

 When the selected service is not running, the status will change to Stopped. 
If the service status does not change but displays Stopping. Then the Stop 
operation has failed. Use the Windows Task Manager to End the process. 

 

Starting up with Windows: 
The installation program sets up the server applications to be started manually. These 
applications can also be automatically started when Windows starts. 
 

 Open the Windows Services application from Control Panel->Administrative 
Tools->Services. 

 Right-click on the Service that you what to update.  

 From the menu select Properties. 

 Change the Startup Type from Manual to Automatic in the General tab. 
 

 



Starting and Stopping 

Administrator Guide  6-7 

To Modify Recovery Actions 
 

 Open the Windows Services application from Control Panel->Administrative 
Tools->Services. 

 Right-click on the Service that you what to update.  

 From the menu select Properties and click on the Recovery tab. 

 From the pull down list select the recovery option. By default this is set to 
restart the service upon failure. 
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Verifying Server Operation 

To Stop Unified CallConnector Servers 
The Unified CallConnector Server applications can be started in several ways: 

 From the CTI Services Manager Application 

 From the Windows Services 

Stopping Using CallConnector Services Manager 
From the Start-Programs menu, select the Cisco Systems group and select the Cisco 
Unified CallConnector Server option, then click on CallConnector Service Manager. 
 
The CallConnector Services Manager application will run and display the following 
window. 

Stopping from Windows Services 
 

 Open the Windows Services application from Control Panel->Administrative 
Tools->Services. 

 Select the Service that you what to stop by clicking on the service name.  

 Click on the Stop button or right-click and select Stop. 

 When the selected service is not running, the status will change to Stopped. 
If the service status does not change but displays Stopping. Then the Stop 
operation has failed. Use the Windows Task Manager to End the process. 
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 Data Management 
 
 
 
 
 
 
The Unified CallConnector Server stores configuration, contact and transaction data in 
databases. This section provides information the procedures for the management of this 
data. This chapter provides an overview of the Unified CallConnector databases, the 
server dependencies on the data and the procedures for managing the data. It includes: 
 
 
UCC Databases:  Provides an overview of the Unified CallConnector 

databases.  

Data Dependencies: Describes the data requirements for the Unified 
CallConnector servers. 

Managing the Data:  Describes the procedures for maintaining the Unified 
CallConnector data including backing up and restoring. 

Importing Contacts:  Describes the method for importing the corporate 
database entries. 

Transaction Data:  Describes the steps for managing the call log and other 
Unified CallConnector transactional data. 
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UCC Database Overview 
The Unified CallConnector Server maintains configuration, contact and transaction data 
in three relational databases - UCCDatabase, Corporate and CallLog. The data is 
accessed using standard SQL commands through the Windows ODBC drivers. This 
allows the Unified CallConnector Server to be agnostic to the underlying database 
system.  
 

For the smaller configurations, the Microsoft Access database is used as the database 
system.  
 
 
 

UCC Database 
The UCCDatabase maintains the configuration and personal contact information. The 
main tables and the information they contain is listed below: 
 

USERS - UserID, Login Name, Password, User Type 

GROUPS  - Group/Department names 

PHONES  - Phone Name, Password, MAC & IP address 

ACCESS CONTROL  Blocked users/groups 

USER-ASSOCIATION TABLES -- associates user with their resources 

PERSONAL – Personal contact data 

SPEED – Personal Speed Numbers 

RULES -- User’s Automation Rules 
 
The information in the Users, Groups, Phones and the Access Control tables are updated 
through the Unified CallController Server Wizard. The Personal, Speed and Rules tables 
are updated from the user interfaces in Outlook and Internet Explorer.  

CallLogs 

UCC   
Database 

Corp. Dir DIRECTORY 

RULES 

PERSONAL 

SPEED 

CALL LOGS 

Database 
System  

Data   
Access   SQL 

USERS 
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Notes on UCC Database 

User Login Name 
The corporate database can contain both Unified CallConnector user and non-user 
information. The user login name in the corporate directory distinguishes the record as a 
Unified CallConnector user. This information is required and should not be changed when 
the data is manipulated using external database tools. 

Department Field 
The value in the department field of the corporate database is used to group users in the 
Status window. In other words the users in the Status view are grouped by the 
department they belong to. The Status window also displays the number of users in the 
department that are currently logged in and available. 

Telephone Numbers 
Telephone numbers in the corporate directory are saved in the canonical format. This 
means that the number format includes the country code preceded by a plus sign, area 
code in brackets and separated from the subscriber number with a space. One exception 
to the canonical formatting is that the country code is not inserted for the current location. 

Access Rights 
Corporate directory entries can be changed only from administrative accounts. User’s 
can change their contact information from the Popup->Options window. User’s can 
change their availability status using the toolbar buttons. 

Corporate Database: 
The corporate directory is a key database in the Unified CallConnector server 
environment. This is used to store shared contact information accessible to all the Unified 
CallConnector users. The  information in the corporate database is used by a number of 
applications including: 
 

 QuickSearch queries the corporate directory database are returns the 
resulting results. 

 The Corporate window in the Contacts window displays the information from 
the corporate database. 

 The Presence Server generates the Status hierarchical display from the 
corporate directory data.  

 The Presence Server saves the availability status of users in this database. 
The user’s current presence status is displayed in the directory search 
results. 

 Call Logs are generated and written to the call log database only for the 
Unified CallConnector users. The caller or called number must match one of 
the user’s contact numbers and the user must be a Unified CallConnector 
user. 

 Instant Messages can be sent to Unified CallConnector users. The 
destination address is obtained from the corporate directory. 
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The corporate database stores two types of information: 
 

Shared contact data for the organization.  

Unified CallConnector user contact data. 
 
The Unified CallConnector user information is added to the corporate directory when the 
users are created using the Server Wizard. Users can change their contact details from 
the Popup->Options window or from the Contacts->Corporate directory view, 
 
Information about other contacts can be added to the Corporate directory from the 
Contacts window or imported into the corporate directory. 

Notes on Corporate Directory 

User Login Name 
The corporate database can contain both Unified CallConnector user and non-user 
information. The user login name in the corporate directory distinguishes the record as a 
Unified CallConnector user. This information is required and should not be changed when 
the data is manipulated using external database tools. 

Department Field 
The value in the department field of the corporate database is used to group users in the 
Status window. In other words the users in the Status view are grouped by the 
department they belong to. The Status window also displays the number of users in the 
department that are currently logged in and available. 
 

Telephone Numbers 
Telephone numbers in the corporate directory are saved in the canonical format. This 
means that the number format includes the country code preceded by a plus sign, area 
code in brackets and separated from the subscriber number with a space. One exception 
to the canonical formatting is that the country code is not inserted for the current location. 

Access Rights 
Corporate directory entries can be changed only from administrative accounts. User’s 
can change their contact information from the Popup->Options window. User’s can 
change their availability status using the toolbar buttons. 

Call/Transaction Database: 
The CallLog database stores the call transaction logs and the instant message 
transactions. The transaction data is stored only for the Unified CallConnector users. 
Several conditions have to be met for a call log to be written to the call log database: 
 

 The Radius service on the router needs to be properly configured to send 
accounting packets to the Unified CallConnector server. 

 The Presence Server has to be running and receiving the accounting records 
from the router. 

 Call Logs are written for the Unified CallConnector users. The users have to 
be configured using the Server Wizard and their records should be present in 
the corporate directory. 
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 One of the user’s telephone numbers must match the IP Phone extension 
number. 

 

Notes on Call Log Directory 

User ID 
Each call log record is associated with a user based on the user-id parameter. This 
means the call log is only visible to individual users. If multiple users have the same 
phone number, then a separate records is written for each user. Users can manage their 
log entries from the log window. 

Name Lookup 
The caller and called telephone numbers are matched in the corporate directory to lookup 
the names. If there is a match then the name is written in the call log database. 
 

Data Dependencies 
This section highlights the dependencies between some of the key features of the Unified 
CallConnector and the data in the database system. 

User Authentication 
All users need to log in to the Unified CallConnector to access the system features.  This 
authentication is carries out during the SIP registration process. The following data from 
the Users table in the UCCDatabase is used verify the user account. 
 

 LoginName: This is the login name assigned by the administrator when the 
user account is created. 

 Password: Password used to authenticate the account. 

User Type 
Each user account needs to be assigned a user type. Three user types are supported – 
User, Manager and Administrator. The default account type is User.  Generally, the user 
type determines the read/write (or add, modify and delete) rights. 
 

 The user types are defined in the UserType table in the UCCDatabase. 

 The foreign key FK_UserTypeID in the user table associates the user 
account with the type information. 

Phone Association and Authentication 
Each user account in the Unified CallConnector can be associated with one or more IP 
Phones. The users are able to view call information from these phone and are able to 
control these calls. 
 

 The Phones table in the UCCDatabase stores the details of the IP Phones 
configured in the Unified CallConnector system. 

 The UserPhones table maintains the list of the phones associated with the 
user. 
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Access Rights 
 
A set of tables contain the list of users and groups that are allowed to access the status 
informations. 

Presence Groups and Users 
The Unified CallConnector Status window organizes the user in Groups. This Group is 
the department that the user belongs to in the organization. Each user can belong to one 
group.  

 The Group names are defined by the Server Wizard and stored in the 
Groups table in the UCCDatabase. 

 The associated between the user and their group is maintained by the 
UserGroups table. 

 Users need to be associated with the groups defined in the Groups table for 
the access control rights to be applied. 

Telephone Status in Presence 
The telephone status information is displayed in the Status window. Thus information is 
only displayed for contacts in the corporate directory whose telephone number matches 
the extension number of the IP Phone receiving or making the calls.  

 Match for the caller and called ID numbers is checked against the 
BusinessPhone, HomePhone or Mobile numbers in the corporate directory.  

 If the number matches then the call state of that number is published to the 
Status window.  

Call Logs for Each User 
The call log data is saved in the CallLog database only for UCC users.  

For a call log to be saved in the database the caller or called IP Phone extension 
number must be in the corporate directory. 

The corporate directory record must be a Unified CallConnector user.  
 
Note: The corporate directory stores both UCC-user and non-user contact information. If 
you are importing contact information to the corporate directory, the user account 
information should be maintained. 
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Maintaining the Data 
This section describes how to backup, restore, repair, import, and export the Unified 
CallConnector databases.  

Backing Up Databases 
Backing up the directory data allows you to keep a copy of the database for future data 
recovery.  It is recommended to backup your database on a regular basis in order to keep 
your backup data current. 

To Backup the Databases 
 Stop the Unified CallConnector Database Server. The server can be stopped 

from Administrative Tools->Services window. 

 Run the Unified CallConnector Server Wizard and go to the Database 
section. 

 Click on the Backup button. The files will be copied to the Databackup folder. 

 You can also copy the database files to the backup folder. The Access 
database files have the .mdb extension. 

 Restart the Unified CallConnector Database Server. 
 

Restoring Databases 
If a directory database gets corrupted, you may restore the database from backup. Any 
new information in the database will be lost when the data is restored.  

To Restore  the Databases 
 Stop the Unified CallConnector Database Server. The server can be stopped 

from Administrative Tools->Services window. 

 Run the Unified CallConnector Server Wizard and go to the Database 
section. 

 Click on the Restore button. The files will be copied to the Data folder. 

 Copy the specific database file that you wish to restore from the backup 
folder to the Unified CallConnector Server->Data folder. This will override the 
existing data file. 

 Restart the Unified CallConnector Database Server. 
 
Note: The transaction information such as call logs is stored in the CallLog database, the 
shared contact information is saved in the Corporate database and the configuration and 
personal data is stored in the UCC Database  

Compacting the Databases 
When records are deleted in the database, they are marked as not available. The deleted 
record remains in the database. The ;Compact’ operation removes these deleted records. 
For databases with frequently changing data, such as the Calllog database, the 
compacting operation can be used to remove these un-used records. 
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To Compact the Databases 
 Stop the Unified CallConnector Database Server. The server can be stopped 

from Administrative Tools->Services window. 

 Run the Unified CallConnector Server Wizard and go to the Database 
section. 

 Click on the Compact button. The files will be compacted. 

 Restart the Unified CallConnector Database Server. 
 

 

To Compact the Databases from ODBC 
 Stop the Unified CallConnector Database Server. The server can be stopped 

from Administrative Tools->Services window. 

 Open the Data Sources (ODBC management) window from Administrative 
Tools-> Data Sources.  

 Click on the System DSN tab. The Unified CallConnector databases will be 
displayed. Select the database that you want to compact and click on 
Configure button. 

  The Configure button will open the ODBC Microsoft Access Setup widow. 
Verify that the correct database has been selected and click on Compact.  

 
Restart the Unified CallConnector Database Server. 
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Repairing the Databases 
The repair operation rebuilds the indexes that allow a database to quickly search and retrieve 
data.  

 

To Repair a Database 
 Stop the Unified CallConnector Database Server. The server can be stopped 

from Administrative Tools->Services window. 

 Open the Data Sources (ODBC management) window from Administrative 
Tools-> Data Sources.  

 Click on the System DSN tab. The Unified CallConnector databases will be 
displayed. Select the database that you want to repair and click on Configure 
button. 

  The Configure button will open the ODBC Microsoft Access Setup widow. 
Verify that the correct database has been selected and click on Repair.  

 
Restart the Unified CallConnector Database Server. 
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Importing and Exporting Contacts 
 
The Microsoft Access database tools for importing and exporting can be used to populate 
the corporate directory data.  The Corporate Directory database can also be exported. 
 

 

To Import Data to the Directory 
 

 Stop the Unified CallConnector Database Server. The server can be stopped 
from Administrative Tools->Services window. 

 Open the Corporate database from Microsoft Access.  

 From the File menu, select Get External Data->Import. The import window 
will be displayed.    

 Select the file and the file type and run through the import wizard. 
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To Export Data from the Directory 
 

 Stop the Unified CallConnector Database Server. The server can be stopped 
from Administrative Tools->Services window. 

 Open the Corporate database from Microsoft Access. Double-clock on 
Directory  to open the table. 

 From the File menu, select Export->Import. The export window will be 
displayed.    

 Select the file and the file type and run through the export wizard. 

Maintaining CallLog Data 
The CallLog database stores records for the phone calls made through the Cisco Unified 
CME. These records can accumulate and build up to a large number, increasing the size 
of the database and impacting the performance when viewing the logs. 
 
The Unified CallConnector Server Wizard provides an option to automatically remove the 
call log records that are older than the selected date. 
 

To Automatically Purge Call Log Records 
 

 Start the Server Wizard. Click on Database Server or click on Next to move 
to the Database Server window. 

 Select the option ‘Remove Call Logs older than (in days)’ and from the pull-
down list select the number of days of call log data you want to keep in the 
system. 

 Click on Finish to apply the changes.    

 Select the file and the file type and run through the export wizard. 

 Stop and start the Unified CallConnector Database Server. 
 
 
 
 
 





 

User’s Guide 

 Server Diagnostic Tool 
 
 
 
 
 
 
 
 
 
The Unified CallConnector Server Diagnostic Tool allows you to view the status of the 
server applications, configuration information and  run diagnostic tests.  
 
This chapter describes the information available from the Diagnostic Tool and provides 
instructions for running the tests. It includes: 
 
Tool Overview:  Describes the different attributes and functionality 

available from the Toolbars. 

Main Window: Describes the Diagnostic Tools user interface and the 
different window sections. 

Running Diagnostic Tool: Describes how to setup an account(s) for use when 
running the tests  

Server Test Suites: Provides an overview of the Server test cases and 
description of the information returned when the test is 
run. 

Client Test Suites: Provides an overview of the client test cases and 
description of the information returned when the test is 
run. 

Results Discussion: Describes the implication of the test result success or 
failure. 
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Server Diagnostic Tool Overview 
The UCC Server Diagnostic tool can be used to isolate problems with the Unified 
CallConnector Server applications. The Diagnostic Tool can display configuration 
information, connection status and statistics for the servers. The Tool also contains a 
suite of diagnostic tests that can be run to determine possible causes for problems 
experienced when running the UCC clients in the server mode. 
 
The Diagnostic Tool can be run on the Unified CallConnector Server or on the client 
desktop. Note it the Tool runs only on Windows 2003 or Windows XP systems. 

Diagnostic Tool Capabilities 
The Unified CallConnector Diagnostic Tool can be used to: 
 

 Run client and server diagnostic test suites: 

 Display User, Group, Phone configuration information 

 Display Server Status and Statistics 

 Display Phone Status and Statistics 

 Display Radius Inputs, Call Logs, and Active calls 

 Display Registered and Subscribed Users 
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Diagnostic Tool Main Window 
The regions of the Diagnostic Tool window are described below starting from top left and 
going to bottom right: 

 

Menu Bar:  The menu provides access to the functions of the diagnostic tool: 

Toolbar:  Provides buttons for selecting or setting up the test account and 
running the tests. These functions include starting and stopping 
a test suite, saving, printing or clearing the test results and 
information. 

Folders:  The diagnostic tests are organized under server and client 
folders. Each server application is associated with its own set of 
test suites. 

Test Suites:  A test suite is a collection of unit tests that request information or 
attempt to isolate a problem.  

Information Window:  The Information Window displays the messages received in 
response to the queries sent by the tool as the tests are 
executed.  

Results Window: The Results Window displays each test that has been run with an 
indication of the test result – success or failure. 

 TOOLBAR 

 FOLDER 

TEST SUITES 

INFORMATION 
WINDOW 

RESULTS 
WINDOW 
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Menu Bar 

 File Menu:  
 Manage Connection - opens the Connections window to setup a user 

account to run the tests on 

 Save – allows you to save the contents of the Information and Results 
windows to a selected a file 

 Print – prints the contents of the Information and Results Window 

 

 View Menu: 
 Toolbar – displays the toolbar below the menu bar when selected. 

 Status Bar – displays the status bar at the bottom of the window when 
selected. 

 Dialog Test – not currently implemented 

 Toggle Test Suite Tree –  not currently implemented 

 

 Actions Menu: 
 Reload All Test Suites –  not currently implemented  

 Launch Test Suite Builder –  not currently implemented 

 Help Menu: 
 Help – opens the Diagnostic Tools About dialog window 

Toolbar 
 

 

Current Account 

Add New Account/User 

Save Results Expand & Collapse 
Tests 

Open 
Help 
File  

Run a Test Test Properties 

Stop a Test 

Erase Diagnostic  
Information  

Test Parameters 

Run All & Stop All 
Tests 
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Toolbar Button Description 

Current Test Account Each test is a Unified CallConnector user account under which it 
is run. The current account displays the active user account that 
is be used or will be used by the selected tests. More than one 
test account can be setup 

Add New Accounts 

 

The New Account button allows you to specify a new user 
account. It opens the New UCC Account window for entering the 
SIP server address and user login information. You need to 
specify the account name 

Save Results 

 

Opens the ‘File Save As’  to allow you to specify the file name 
and location for saving the Information and Results window 
information. 

Save Results 

 

Opens the ‘File Save As’  to allow you to specify the file name 
and location for saving the Information and Results window 
information. 

Open Help Displays the Diagnostics Tool help window. 

Expand Tests 

 

The Test Suite is displayed as a hierarchical tree. This button 
expands the all the Test Suites to display the Unit Tests 
associated with each suite. 

Collapse Tests Collapses the hierarchy to display only the test suites. 

Run a Test Runs the currently selected test suite or test, 

Stop a Test Stops the currently selected test suite or test, 

Erase Diagnostic 
Information 

Clears the data displayed in the Information and Results windows 

Display Test Parameters Open Test Suite Hierarchy to display the parameter field being 
used for each of the tests 

Display Test Properties Opens the Properties window for the selected item in the test 
Suite list 

Run All Tests Run all the tests in the selected test suite 

Stop All Tests Stop running all tests 
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Folders 
Folders provide access to the test suites. The diagnostic tests are organized in test suites 
which are associated with items in the folders.  
 
There are two folders – Server and Client.  
 
The server folder has an entry for each of the Unified CallController server applications. 
Example of these are the CallController or Presence Server. When you select an entry in the 
folder, the test suites associated with that entry are displayed in the Test Suites window. 
There may one or more test suites associated with each entry. 
 
The Client Folder has one entry for all the client test suites. 
 

To View Available Test Suites 
 Select the Folder by clicking on Servers or Clients. 

 Select the Folder Entry by clicking on the item. 

 The list of available test suites for the entry will be displayed in the Test 
Suites window. 

 
 
 
 
 
 

Test Suites 
A Test Suite is the problem that you want to diagnose or the type of information that you 
want to view from the server. 
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Each test suite can be comprised of a number of individual tests. Test Suite attempts to 
isolate the problem by validating each of the requirements for that function. 

 
In the example above, to determine why the use is unable to make calls, the following 
steps have to be validated.  
 

 Login to the UCC system using the account of the user that is 
experiencing the problem. 

 Connect to the Database Server. If this fails then the user account 
cannot be accessed as there is a problem connecting to the Database 
Server. 

 Obtain the user’ account information. This is to verify that the user has 
an account on the server 

 Obtain the user’s phone information. If no phones are configured then 
this will fail. 

 Verify that the phone is connected to the Unified CallConnector and is 
available. 

 And finally an attempt is made to place the call. 

Diagnostic Information Window 
 

 
The Information window displays the results from the individual test that is run. A test 
may return a single line of result or many responses. 
 
Each of the responses is displayed in three lines. 

 ViewClass: The first line is the message type. This is the beginning of a response 
entry. 

 Parameter - Line After ViewClass: List of the parameters or the fields that are 
send in the message. Each ViewClass messages has its own list of fields. 

 Value – Value of parameters listed in the previous line. The value for each of the 
fields or parameters returned in the response message is listed below its 
Parameter or Field name. 

 
For Example in the display above: 
ViewClass=DirQueryResult. This message returns information from the database. 
 
The fields returned include the  Display Name, User Type Login Name etc. 
The value of these fields is in the next line, respectively Richard Tran, 3, rtran etc. 



Chapter 8 Server Diagnostic Tool 

8-8  Cisco Unified CallConnector Server  

Test Results 
The Results window indicated is the particular test was a success or failure. For each test 
run there will be a corresponding result status . 
 

 

Test Parameters 

 
 
The parameters required in each of the tests is displayed in the parameter list. The 
parameters can be displayed by highlighting the test and clicking on the toolbar button – 
Display Test Parameters or by double clicking on a test entry. Each test can inherit the 
results from the prior test(s) in the test suite. You can right-click to open the properties 
window and change the inheritance rules or enter a specific For example in the Make a 
Call test, the telephone number to be dialed can be entered as a parameter. 



Server Diagnostic Tool 

  Administrator Guide  8-9 
 

Running the Diagnostic Tool 
 Copy the ccUCCDiagnostic.exe and UCCDiagnostic.xml file to the tools 

folder of the UCC client. 

 Diagnostic Tool can also be run from a shared drive or on the CallConnector 
server. 

 The computer where it is run needs to have the UCC client or server 
installed. Ports setup for the Tool must not be blocked. The Diagnostic tool is 
not compatible with Windows 2000. 

 Double Click on ccUCCDiagnostic.exe. The UCC Server Diagnostic Tool will 
run. 

 Setup or select the account you want to use for the tests. 

 Click on the Server or Client Folder button and select the folder by clicking on 
the icon. 

 Click on the Test Suite that you want to run. 

 To execute the test, click on the Run button.             

 You can also right-click and select Run Test Suite  

 The tests will run and display the information in the Information Window and 
success/failure in the Results Window. 

Creating a New Account 
 

 
 

 Click on the Create New Account button on the top left hand corner on the 
toolbar (next to Accounts dropdown menu). 

 It will bring up a window where you can create a new Account. Enter the 
following information in the New Accounts window: 

o The ID you would like to give to this account (to distinguish between 
other accounts) 
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o The username and password of an account on the Unified CallConnector 
Server you are currently troubleshooting. 

o The IP address of the Unified CallConnector Server you are currently 
connecting to. 

o The port where you will use to access the UCC Server. 

 When you are finished, click on Create to create this account. You can create 
new accounts. However, you cannot edit any existing accounts. 

 

Selecting a Client Test Suite 
 On the left hand side of the Diagnostic Tool window, from the Folder menu  

click on the Client Test Suites button. By default, the Server button is open 
when you first open the Diagnostic Tool. The Client Test Group button is at 
the bottom of the folder menu. 

 Click on the All Clients button. A list of the client test suites will be displayed 
in the Test Suites window to the right. 

 Click on the plus sign of any test suite to expand and show a list of different 
tests under the test suite. 

Selecting a Server Test Suite 
 On the left hand side of the Diagnostic Tool window, from the Folder menu  

click on the Server button. By default, the Server button is open when you 
first open the Diagnostic Tool. The Server button is at the top of the folder 
menu. 

 A list of folders representing a group of tests for each Unified CallConnector 
Server components is displayed. This allows the you to test each component 
individually. Note however that some components are dependent on other 
components in order to work. 

 The Server folders listed are CallController Server, Database Server, 
Presence Server, System SIP Server, and System Tracker. Click one of 
these icons to select that group of tests. 

 A list of the test suites for that server component will be displayed in the Test 
Suites window to the right. 

 Click on the plus sign of any test suite to expand and show a list of different 
tests under the test suite. 

Starting and Stopping a Test 
 After you have selected a test suite to run, expand the test suite by clicking 

on the plus button next to it. 

 It will display a list of tests that must pass in order for this functionality to 
work. 

 Because each test suite is associated with its own individual account, please 
be sure to select the correct account that you would like to use from the 
Account Dropdown menu. You may select an account from the drop down 
menu, or create a new one by clicking on the marker button next to it. If you 
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do not select the correct account, you may be running these tests on a UCC 
Server account you were not intending to troubleshoot. 

 Some tests (one level under test suites) will require parameters to be filled in. 
If there is a tiny box icon next to a test, this means that it will automatically fill 
this parameter and you needn’t worry about it. But if it does not have a box 
icon next to it, you may need to fill in this parameter. 

 Right click on the test suite and click on the Run Test Suite option to start the 
test suite. 

 You may also start a test suite by selecting a test suite and then clicking the 
green play button from the menu at the top of the screen. 

 After the test is finished it will stop automatically. 

 If you would like to stop the test at any time while it is running, you may right 
click on the test suite and select the Stop Test suite option. You may also 
click on the Stop Button from the menu at the top of the screen. This will also 
stop the current selected test from running. 

 

Start and Stop All Tests 
 You may run through all the tests by clicking on the Run All Test Suites 

button located on the toolbar menu at the top of the screen. 

 You may stop these tests from running by clicking on the Stop All Tests 
button. 

Interpreting the Test Results 
 After running a Test suite, the tool will display a green check mark to all tests 

that have passed and a red X mark to all tests that have failed. 

 In the Results window, it will also display the results (pass or fail) of each test 
case. 

 If the result of a particular test has failed, you can find the list of possible 
causes of this failure in the Test Results Appendix in this Help File. 

To Clear the Information and Results Window 
 To clear the Tests Results (success and error messages) and Information 

Data (data messages received from Servers), click on the Erase button 
located on the top toolbar menu. 

 Clicking this will erase all data and result messages. 

Saving Test Results a File 
 Click on the floppy disk icon located on the top toolbar menu. 

 This will bring up a prompt to save the Information Data. If you do not want to 
save the Information data, click cancel to continue to saving the Test Results. 

 After you are finished saving the Information Data, you will be prompted to 
save the Test Results. If you do not want to save the Test Results, then 
please click cancel. 
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Clearing Test Status 
 After running through test suites, you may notice that the status check marks 

are not removed from the test suites and tests. 

 It will remain there for your own convenience and will not be erased until you 
exit the Diagnostic Tool application or hit the Stop Test button or Stop all 
Tests button. 

 To clear the status check marks from a particular test suite, select the test 
suite and click on the Stop Test button on the toolbar menu located at the top 
of the screen. 

 To clear all the status check marks from all tests suites in the Test suite 
Menu, simply click on the Stop All Tests button on the toolbar menu located 
at the top of the screen. 

To View the Test Parameters 
 To view parameters used in a test, expand the test suite and right click on a 

test. Then select the properties option. 

 It will show the parameters being used by this particular test. 

 Parameter Settings: 

o If the Auto-fill check box is checked, it will automatically fill these 
parameters upon running it. If Auto-fill it is unchecked, then you may 
check it to have it automatically fill in parameters or you may fill in these 
parameters manually. 

o You may have the test suite stop execution upon test failure by checking 
the Stop Execution upon Any Test Failure box. If it is not checked it will 
continue execution if any test fails. 

o It is recommended that you have the Auto-Export setting checked. This 
will automatically export all test results to the rest of the tests so that the 
Auto-fill feature will work. 

To Displaying the Tests in a Test Suite 
 When you first open a Client or Server Test Group, it will show you a 

collapsed list of Test suites. 

 To expand a specific Test suite, click on the Expand button located to the left 
of the Test suite. 

 You may also expand a specific test suite by clicking on the plus button next 
to the left of the test suite.  

 You can expand all sub directories of the test suites (showing tests and their 
parameters) by clicking on the Expand All button located on the toolbar menu 
at the top of the screen. 
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To Hide the Tests in a Test suite  
 When you first open a Client or Server Test Group, it displays a collapsed list 

of test suites. 

 If you happen to have any of these test suites expanded you can collapse 
one test suite by selecting it. Then select the Collapse button located to the 
left of the test suite to hide all the tests under the test. 

 You may also collapse a test suite by clicking on the test suite and clicking 
on the Collapse button on the toolbar menu at the top of the screen. 

 You can hide all sub directories of the test suites (hiding tests and their 
parameters) by clicking on the Collapse All button located on the toolbar 
menu at the top of the screen. 
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Test Results Discussion 
This section describes possible problems related to the failed tests. This should be 
helpful in troubleshooting UCC problems. 

Server Tests 

 CallController Server 
 Verify Access to CallController Server: Checks to see if a connection can be 

established with the CallController Server. 
o Success: The CallController Server is online, running, and connection 

can be established with it. 
o Failure: The CallController Server is offline, not running, or connection 

cannot be established with it (possible firewall issues). 
 

 Display User’s Phone Statistics: Returns statistics of the user’s phone. 
o Success: Statistics of User’s phone which includes: Number of times 

disconnected, number of errors, number of incoming calls, number of 
outgoing calls, ID of the phone, number of times phone reconnected from 
failure, number of times the phone was reset, the status of the phone, 
and the total number of calls (incoming/outgoing). 

o Failure: Cannot Contact CallController Server or there is no phone 
associated with this user. 

 
 Query Statistics of All Phones: Returns statistics of all phones associated with 

this UCC Server. 
o Success: Statistics of all phones associated with this UCC Server, which 

includes: Number of times disconnected, number of errors, number of 
incoming calls, number of outgoing calls, ID of the phone, number of 
times phone reconnected from failure, number of times the phone was 
reset, the status of the phone, and the total number of calls 
(incoming/outgoing). (It will show list of statistics for all phones, 
differentiated by Phone ID) 

o Failure: Cannot Contact CallController Server or there are no phones 
associated with this UCC Server. 

 
 Query Status of User’s Phone: Checks the status of the user’s phone: The main 

phone number, the phone ID, and the phone’s status. 
o Success: It returns the status of the user’s phone 

(Idle/Busy/Disconnected). 
o Failure: The CallController Server is offline or the user is not associated 

with a phone. 
 

 Query Status of All Phones: Checks the status of the all phones connected to this 
UCC Server: The main phone number, the phone ID, and the phone’s status. 

o Success: It returns the status of the user’s phone 
(Idle/Busy/Disconnected). 

o Failure: The CallController Server is offline or the user is not associated 
with a phone. 

 
 Phone Lines Not Available: Checks to see if the user can obtain phone lines. 

o Success: It returns a list of the user’s phone lines (phone DN’s). 
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o Failure: The CallController Server is offline, the user is not associated 
with a phone, or the user’s phone is disconnected. 

 
 Unable to Make or View Calls: Checks to see if the user can obtain phone lines. 

o Success: It makes an outgoing phone call. 
o Failure: The Client is unable to contact the CallController Server, the 

user is not associated with a phone, or the user’s phone is disconnected. 
 

Database Server 
• Verify Access to Database Server: Checks to see if a connection can be 

established with the Database Server. 
o Success: The Database Server is online, running, and connection can be 

established with it. 
o Failure: The Database Server is offline, not running, or connection 

cannot be established with it (possible firewall issues). 
 

• Unable to Login: Checks the Database for your account username and 
password. 

o Success: The Database is running and is able to verify correct username 
and password. 

o Failure: The Database Server is not running, or the account information 
used is incorrect. 

 
• Speed Dial Numbers are Not Displayed: Requests a list of Speed dial entries for 

this user from the Database Server. 
o Success: The Database Server was able to return all speed dial results. 
o Failure: The Database Server is either not running or speed dials may 

have not been created yet. 
 

• Display All User Accounts: Checks the Database for all user accounts. 
o Success: The Database is running and returns all user account 

information. 
o Failure: The Database Server is not running, or there are currently no 

user accounts on this UCC Server. 
 

• Display All Phones: Displays a list of all phones associated with this UCC Server. 
o Success: The Database is running and returns all phones connected to 

this UCC Server. 
o Failure: The Database Server is not running, or there are currently no 

phones controlled by this Server. 
 

• Personal Contacts are Not Displayed: Requests a list of all Personal Directory 
Contacts from the Database Server. 

o Success: The Database Server was able to return all Personal Directory 
Contacts. 

o Failure: The Database Server returned nothing. The Database Server 
may be offline or something could be blocking the query from being 
received by the Database Server. It’s possible that the user may not 
have any Personal Directory Contacts. 

 
• Call Logs are Not Displayed: Requests a list of all Call Logs from the Database 

Server. 
o Success: The Database Server was able to return all Call Log results. 
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o Failure: The Database Server returned nothing. The Database Server 
may be offline or something could be blocking the query from being 
received by the Database Server. It’s possible that the user has no call 
logs. 

 
• Display Latest Call Logs in Database: Requests a list of all Call Logs from the 

Database Server. 
o Success: The Database Server was able to return the 10 most recent 

call logs written to the Database. 
o Failure: The Database Server returned nothing. The Database Server 

may be offline or something could be blocking the query from being 
received by the Database Server. It’s possible that the user has no call 
logs. 

 

System SIP Server 
 Display Registered Servers and Users: Displays the current list of registered 

users and servers. 
o Success: Returns a list of registered users and Servers. 
o Failure: The System SIP Server is offline, or none of the other services 

are running. 
 

Presence Server 
• Verify Connection to the Presence Server: Checks to see if a connection can be 

established with Presence Server. 
o Success: The Presence Server is online, running, and connection can be 

established with it. 
o Failure: The Presence Server is offline, not running, or connection 

cannot be established with it. 
 

• Display All Groups: Requests a list of all user groups from the Presence Server. 
o Success: Returns a full list of all user groups. 
o Failure: The Presence Server is down, or unable to populate its list of 

groups and users. It’s possible that the Database Server was down when 
the Presence Server was started so it wasn’t able to obtain the 
information it needs to run properly. 

 
• Presence Status is Not Displayed: Requests the status of the user from the 

Presence Server. 
o Success: The Presence Server is online and returns the user’s status. 
o Failure: The Presence Server is offline or is not ready. It’s possible that 

the Database Server was down when the Presence Server was started 
so it wasn’t able to obtain the information it needs to run properly. 

 
• Query Presence Server’s Latest Call Logs: Requests a list of the last 10 call logs 

that were written by the Presence Server. 
o Success: Returns the last 10 call logs written by the Presence Server. 
o Failure: No call logs are returned. The Presence Server is either offline, 

is not ready, or the Radius Packets are not being sent to this UCC 
Server. If radius has not been configured, then it’s not possible to see 
Call Logs being written. 
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• Display Current Subscribers to the Presence Groups: Requests the list of 
currently subscribed users of the Presence Server. 

o Success: Returns the list of subscribed users. 
o Failure: The Presence Server is offline, not ready, or there are no 

subscribed users. 
 

• Display Current Active Calls: Requests the list of current active calls being made. 
o Success: Radius packets are being sent to this UCC Server. Returns the 

list of active calls. 
o Failure: The Presence Server is offline, not ready, or there are no active 

calls. 

System Tracker 
• Display Server Connection Statistics: Attempts to establish a connection with the 

System Tracker. 
o Success: The System Tracker is online, running, and connection can be 

established with it. Also returns the connection status of all Servers. 
o Failure: The System Tracker is offline, not running, or connection cannot 

be established with it. 
• Server Statistics:  

o SIP Server: 
 Current state of this server. 
 Number of times this server went offline. 
 Current running duration of uptime.  

o CallController Server: 
 Current state of this server. 
 Number of times this server went offline. 
 Current running duration of uptime.  

o Database Server: 
 Current state of this server. 
 Number of times this server went offline. 
 Current running duration of uptime.  

o Presence Server: 
 Current state of this server. 
 Number of times this server went offline. 
 Current running duration of uptime.  

 

Client Tests 
• Servers are Disconnected: This tells if you can or cannot connect to all servers. 

o Success: All services: System SIP Server, CallController Server, 
Database Server, Presence Server, and System Tracker are all running. 

o Failure: One or more of the servers are not running. 
 

• Don’t See Phone Line: Checks to see if the you can make a phone call. 
o Success: It is able to make a phone call correctly. 
o Failure: The CallController Server is offline, the user is not associated 

with a phone, or the user’s phone is disconnected. 
 

• Can’t Control IP Phone: Checks to see if the user can obtain phone lines. 
o Success: It returns a list of the user’s phone lines (phone DN’s). 
o Failure: The CallController Server is offline, the user is not associated 

with a phone, or the user’s phone is disconnected. 
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• Cannot Sign In: Checks the Database for your account username and password. 

o Success: The Database is running and is able to verify correct username 
and password. 

o Failure: The Database Server is not running, or the account information 
used is incorrect. 

 
• Don’t See Speed Dial Numbers: Requests a list of Speed dial entries for this user 

from the Database Server. 
o Success: The Database Server was able to return all speed dial results. 
o Failure: The Database Server is either not running or speed dials may 

have not been created yet. 
 

• Don’t See Personal Contacts: Requests a list of all Personal Directory Contacts 
from the Database Server. 

o Success: The Database Server was able to return all Personal Directory 
Contacts. 

o Failure: The Database Server returned nothing. The Database Server 
may be offline or something could be blocking the query from being 
received by the Database Server. It’s possible that the user may not 
have any Personal Directory Contacts. 

 
• Don’t See Call Logs: Requests a list of all Call Logs from the Database Server. 

o Success: The Database Server was able to return all Call Log results. 
o Failure: The Database Server returned nothing. The Database Server 

may be offline or something could be blocking the query from being 
received by the Database Server. It’s possible that the user has no call 
logs. 

 
• Don’t See Presence Info: Requests a group list and user list from the Presence 

Server. 
o Success: Returns a full list of all user groups and users in those groups. 
o Failure: The Presence Server is down, or unable to populate its list of 

groups and users. It’s possible that the Database Server was down when 
the Presence Server was started so it wasn’t able to obtain the 
information it needs to run properly. 

 
 
 
 
 



 

 

 Troubleshooting 
 
 
 
 
 
 
 
This chapter describes the common error conditions that occur with the Unified 
CallConnector Server and steps to solving these problems. The following are the areas of 
possible error conditions what will be covered: 
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UCC Server Troubleshooting 
 
While using the Unified CallConnector, users may experience some common problems. 
This chapter focuses on troubleshooting these common problems. The troubleshooting 
information contains information on the nature of the problems and steps to solving these 
problems.  
 
The Unified CallConnector system consists of multiple interacting components. These 
components are shown below with a summary of the impact of a failure in a component 
and the appropriate debugging tool. 
 

Summary of Component Failure and Possible Failure Symptoms 
 

A. IP Phone Not Registered; Cannot/Lost Connection to CME Router:  

B. Cannot Register, Cannot Access/Corrupted Database: From Control    Panel  open 
Phone & Modems; Admin Tools ->ODBC ->System DSN 

C. GUI Gray; Unable to Connect/Login: Connectivity Status; Windows Services ->Stop/Start 

D. Reset Activation, Change Configuration: Windows Registry; UCC.XML in System32 

E. Cannot View Information (caller id, search results): Popup Options; UCC Debug Logs 

F. Toolbar Not Showing, IE/Outlook Crash: Unregister/Register.bat files 

G. Activation Timeout: Check firewall and IE settings 
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Cannot Register (TSP Mode) with the IP Phone 

Description 
The Cisco Unified CME router can be successfully pinged, but the Wizard or TSP cannot 
register to CME. 

Possible Causes  
 Invalid user name and password have been entered. 

 Another TSP is running and using the same IP-Phone. 

 Ephone has not been configured with the User Name and Password. 

Procedures 
 Step 1:  Verify that the account information has been entered correctly. Enable CME 

Debug for IP Phone Registration 

 Step 2: Re-enter the information and verify connectivity using the Wizard. 

 Step 3: If the Wizard still displays the error, then contact your system administrator or 
service provider. 

 

Activation Fails with Timeout 

Description 
When Activating Serial Number, the progress bar run through three times and posts an 
error message. 

Possible Causes  
 No access to the Internet from this PC 

 Access to the UnifiedCallConnector.com site is not resolved/available. 

 Firewalls may be blocking Popup access to internet. 

Procedures 
 Step 1:  Verify that there is access to Internet. Browse to www.cisco.com. 

 Step 2:  Verify proxy settings on Internet Explorer, if proxy is in use. 

 Step 3:  Verify that the firewalls on the PC allow Popup external access 

 Step 4: Verify that there is access to the License Server site.  Browse to 
www.unifiedcallconnector.com. 

 Step 5: If the Activation still displays the error, then contact your system administrator 
or service provider. 
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Phone Lines are Not Shown or Cannot Dial 

Description 
When trying to select a phone line from the Popup menu, the phone lines are not shown. 
Or attempting to dial, but the call is not being dialed out. 
 

Possible Causes  
 Client is not logged in. 

 CallController Server is stopped or session to CME dropped. 

 IP Phone has been disconnected or not in service. 

 IP Phone has not been configured with the CME. 

Procedures 
 Step 1: Check whether logged in or logged out.  

 Step 2: If IE or Outlook open, click on Cisco button in UCC Toolbar and check on 
servers in Connectivity. 

 Step 3: Right-click on the red Popup system tray icon, select Options and Click on 
the Server tab.  

 Step 4: If Server Tab displays the Logout button, then logged in. If it shows a Login 
and Reset button, then logged out. 

 Step 5: If you are logged out, then type your Login name and password and click on 
the Login button. If not using UCC Server, uncheck/check ‘Use Local TAPI Driver’ to 
reset user-name and password. 

 Step 6: Check whether or not the CallController Server is down from Option-Server or 
Toolbar->Cisco->Connectivity. 

 Step 7: If in TAPI mode, check in Services to see if the ccCallController service is 
stopped. If it has stopped, then select the service and click the “play” icon on the top 
to start the service. 

 Step 8: If in Server mode, check the CallController Server on the Server machine to 
see if it has stopped. If it has stopped, then start the service from the Services menu. 

 Step 9: Verify that IP Phone is operating properly and all lines are visible. 

 Step 10: If TAPI mode, use TAPITest tool to verify phone operation. 

 Step 11: If Server mode, use the sharpshooter to isolate problems. If problem 
persists, collect debug and report the problem. 
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Call Logs Not Showing 

Description 
When you click on the Logs, none of the Call Logs are shown. 

Possible Causes  
 No Calls have been made. 

 Presence Server is not writing Call Logs because it is stopped. 

 Presence Server not receiving messages from the Radius Server. 

 Your Login name isn’t associated with a contact entry. 

 Your contact’s business phone number hasn’t been filled in. 

Procedures 
 Step 1:  Verify that Call Logs are not being shown. Make a phone call to any number 

and hang up. Open the Call Logs Window in Internet Explorer. Right-click on the 
menu and click refresh. If nothing is shown, proceed with the next step. 

 Step 2: Check if the Presence Server on the Server Machine is stopped. On the 
Server Machine open the Services menu and hit the refresh button. If the Presence 
Service has failed  
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Parts of the Toolbar are Grayed out 

Description 
Some parts of the toolbar such as the presence status buttons and the QuickSearch box 
maybe grayed out. Ask customer which parts of toolbar are grayed to determine area of 
need. 

Possible Causes  
 Auto Recovery has not been turned on (by default this is enabled). 

Some services stopped working, need to determine cause (and restart service) 

Procedures 
 Step 1: Determine which servers are stopped using Toolbar->Cisco->Connectivity. 

 Step 2: Enable Auto Recovery if disabled from toolbar or in UCC.XML file 

 Step 3:  Restart Internet Explorer or Outlook for auto-recovery to be enabled. 

 Step 4: If Servers are stopped, restart the servers using Windows-Services or Popup-
Services. 

 

 

 

1. Local SIP Server not Available – All Objects Grayed Out
2. CallController Server Not Available – Line Display show “ No Phone Lines Available”
3. Presence Server Not Available – Status Window Grayed Out 
4. Database Server Not Available – Shortcuts, Contacts, Logs Grayed Out 

CallController Server or 
Lines not available 

Database Server 
 not available 

Presence Server 
 not available 
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Presence Buttons are Grayed Out 

Description 
The Presence buttons on the toolbar are grayed out and cannot be used. 

Possible Causes  
Presence Server  on UCC Server is stopped. 

Procedures 
 Step 1: View Services status using CTI Services Manager  

 Step 2:  Restart the Presence Server. On the Server machine, open the Services 
menu from Administrative tools in the Control Panel. 

 Step 3:  Select the ccPresenceServer item and press the play button at the top to 
start the service. 

 Step 4: You may have to restart the application that you are running (Internet 
Explorer or Outlook) because the Presence buttons may not refresh when you 
change your availability and location. 

 

Popup System Tray Icon Becomes Gray 

Description 
The red Popup icon in the System Tray becomes grayed out. 

Possible Causes  
 The Local SIP Server has stopped. 

 The System SIP Server has stopped. 

 The CallController Server has stopped and you cannot get phone lines. 

Procedures 
 Step 1:  Check to see whether the Local SIP Server has stopped.  

 Step 2: Right-click on the Popup system tray icon. 

 Step 3: Then move the mouse over the Services menu item. A menu showing the 
status of the local services will appear.  

 Step 4: If the Local SIP Server is stopped, then please start the service by clicking on 
Start All Services. 

 Step 5:  Check to see whether the System SIP Server has stopped. You can check 
this on the server machine that it is running from. In Control Panel\Administrative 
Tools\Services, you can verify if the System SIP Server has stopped.  

 Step 6: If it has stopped, right-click on the service and select start. 

Step 7: Check to see whether the CallController Server has stopped. If you are in TAPI 
mode, open Control Panel\Administrative Tools\Services. Check whether 
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ccCallController service has stopped. If it stopped, right-click on the service and 
select start to restart the service. 

 Step 8: If you are in Server mode, check to make sure whether the CallController 
Server has stopped on the Server machine. You can check that from the Services 
menu. Find the service called CallController Server and see if it is started or stopped. 
If it stopped, right-click on the service and select start to restart the service. 

  

Cannot Login 

Description 
You cannot login. 

Possible Causes  
 Wrong User information. 

 Local SIP Server stopped (TAPI Mode). 

 System SIP Server stopped (Server Mode). 

 Database Server has stopped. 

Procedures 
 Step 1: Check whether you typed in the wrong user information.  

 Step 2: The login information for TAPI mode and Server mode are completely 
different.  

 Step 3: If you are unsure about what your username and password are for either 
modes or you don’t have a username and password, talk to your system 
administrator or service provider for assistance. 

 Step 4: Check whether the Local SIP Server has stopped. If it is stopped, there is no 
way for your client to communicate with the System SIP Server or Local 
CallController to log in. 

 Step 5: On your machine, check in Services to see if the ccLocalSIPServer service is 
stopped. If it has stopped, then select the service and click the “play” icon on the top 
to start the service. 

 Step 6: Check whether the System SIP Server has stopped. If you are logging in, in 
Server mode, the System SIP Server must be running to authenticate the user. 

 Step 7: On the Server machine, check in Services to see if the ccSystemSIPServer 
service is stopped. If it has stopped, then select the service and click the “play” icon 
on the top to start the service. 

 Step 8: Check whether the Database Server has stopped running. In order for the 
user to be logged in the System SIP Server (Server mode) or CallController (TAPI 
mode) needs to be able to access the database to authenticate the user. 

 
 
 


